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Instaliation Instructions

Hardware &
Software
Requirements

Installation
Instructions

1.0 Introduction to LCSS

The Lamprey Control Selection System (LCSS) is a software application
that has been developed to assist in long- and short-term management of sea
lamprey populations in the Great Lakes.

This manual provides an overview of the concepts that form the basis of the
system. This section outlines the hardware and software requirements you
will need to run LCSS, and provides installation instructions. Section 2
summarizes important LCSS concepts. Section 3 outlines the various
functions that you will encounter when using LCSS. Section 4 describes the
user interface and contains procedures and examples of how to use the
system. Appendix A describes the model that forms the foundation of
LCSS, Appendix B provides an overview of the database structure and
Appendix C describes the database interface.

LCSS requires an IBM-compatible computer capable of running Microsoft®
WINDOWS™ version 3.1. We recommend that you run LCSS on no less
than a 486 DX2-66 MHZ with 8MB of RAM and approximately 40 MB
free hard drive space.

The system requires Microsoft Access (version 2.0) to support the database
and interrogative routines. LCSS also requires the presence of a program
called SHARE.EXE, which is part of both MS-DOS and MS-Windows. A
statement in your AUTOEXEC.BAT should look similar to:

C:\DOS\SHARE.EXE /L:500 /F:4096

If this line must be inserted or modified during the installation process, you
should reboot the computer after installing LCSS.

LCSS is an application that was developed using Visual Basic (version 3.0).

1. Start Microsoft Windows.

2. Place the installation disk in drive A or B.

3. In Program Manager, select the File menu and click on Run.

4. Type A:SETIMSL (or B:SETIMSL if you insert the disk into drive B).

The installation program will automatically generate a group window

11 ESSA Technologies Ltd.
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containing a program icons and a help file icon. Whenever you wish to run
LCSS, double-click on the program icon.
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Concepts

System
Overview

2.0 General Concepts

This section describes the general concepts needed for a full understanding
of the Integrated Management of Sea Lamprey (IMSL) Decision Support
Tools. It is phrased from the point of the Lamprey Control Selection
System (LCSS), the main element of the IMSL suite and in most respects
the superset of the functionality of the suite. ISIS, the other main
component, shares the model and most of the internal structure with LCSS.

LCSS is a software tool designed to support the interactive design of the
sea lamprey control program in the Great Lakes. The tasks performed by
LCSS include:

« assistance in the development of specific annual/tactical control
program plans,

. strategic cost/benefit (economic injury level) analysis of alternative
levels of lamprey control,

« exploratory analysis of the effects and benefits of the development of
new barriers to lamprey migration, and

« exploratory analysis of the effects and benefits of emerging control
techniques such as sterile male release.

LCSS can help to integrate control program planning and research by
providing a common tool for program simulation and analysis that is
accessible to both control agents and research staff. As such, the system
combines several practical concepts developed by the lamprey control
agents in tactical program planning with concepts of population dynamics
and modelling common in research circles. This section provides an
overview of some important spatial dynamics concepts that form the
foundation of the LCSS model. Further information about the model is in
the Appendix A.

LCSS applies control options (including lampricide treatment, barriers,
traps and sterile male release) to modelled populations of larval and
spawning phase sea lamprey. The system operates on an inventory of
streams that have produced lamprey that have contributed to lake
populations. Figure 2.1 presents the steps in the simulation of spawning
migration, recruitment, transformation, treatment ranking, selection, and
scheduling. The system considers lake and basin populations of parasitic
phase sea lamprey and the streams and portions of streams that produce
them.

2-1 ESSA Technologies Ltd.
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1 fecundity of females; effects of SMRT scenario; egg to age 0+ survival rate

]
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Calcuiate effects of treatment m
or Proceed to Next Year

Figure 2.1: Steps in the simulation of sea lamprey populations

Basins  The spatial structure of lakes represented in the LCSS combines the basic
units in which populations of lamprey live, Lamprey Basins, and the spatial
units in which people think about and plan control actions, Reporting
Basins.

Lamprey Basins A Lamprey Basin is defined as the area of a lake (or lakes) in which a
single parasitic phase population of lamprey resides. In LCSS, a lamprey

ESSA Technologies Ltd. 2-2
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Reporting
Basins

Reaches &
Chemical
Options

Reach

basin is defined by: I) the set of streams to which spawning phase lamprey
migrate; and ii) the set of streams from which transformers migrate. The
default set of lamprey basins (basin definition 1) defines each of the five
Great Lakes as a basin containing a single parasitic phase population. The
LCSS has the capability to define alternative sets of lamprey basins or sub-
basins within a lake.

The mechanism used to assign the pattern of spawner and transformer
movement allows LCSS users to specify migrations from a single stream
to multiple basins (lake areas) and from multiple basins to a single stream.
For example, streams located near the junction of Lakes Superior,
Michigan and Huron can contribute transformers to each of these three
lamprey basins and receive spawners from each basin.

A Reporting Basin is a collection of streams or lamprey basins for which
an LCSS user wishes to summarize data.

At the level of single lake, a reporting basin and a lamprey basin define the
same area. However, within a large lake such as Lake Superior, the exact
number and extent of individual lamprey populations (or lamprey basins)
is unknown. In addition, various management agencies have defined
management areas of the lakes based on other criteria such as fishery quota
management areas. The mechanisms for defining lamprey and reporting
basins within the LCSS are designed to provide a high degree of flexibility
in both simulating lamprey dynamics and reporting the results of alternative
analyses.

Note: This function has not yet been implemented.

When planning lamprey control, chemical treatments are applied in any
year over the actual extent of a stream where lamprey are abundant. The
specific locations vary from year to year within a stream and consequently
no single set of predefined treatment locations is in use. However, some
general procedures have emerged from the program. For example, in
complex streams such as the Nemadji River (illustrated below), treatments
have been applied to major tributaries or portions of the stream. In some
years, only the Black River or the South Fork and Net River have been
treated, while in other years the entire river has been treated.

To facilitate the simulation of lamprey populations within streams treated
by the LCSS, each stream that is potentially subject to lamprey control
treatments has been defined as consisting of a set of one or more reaches.
Each reach corresponds to a major portion of the stream that has received

2-3 ESSA Technologies Ltd.
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Chemical
Treatment
Options

one or more treatments either individually or as part of a larger treatment.

Reaches are the physical portions of the stream used by larval lamprey. The
sum of reach areas must total the area of the entire stream. The orientation
of reaches (i.e. upstream or downstream of each other) is maintained to
account for downstream movement of ammocetes and the effect of traps on
upstream migrating spawners.

In the example below, the Nemadji River system has been designated as
having three reaches:

« the Black River;
« the South Fork, including the Net River; and
« the main stem of the river into which the other two reaches drain.

Lake
Superior

$10712
Nemadji River

North Fork Nemad|l R,

South Fork

Nemadji R. Black River

Net River Falis

Within the LCSS database, chemical treatment options have been defined
for each reach, and for each set of reaches which historically have been
treated together.

In the example of the Nemadji system, chemical treatment options have
been defined for

« the Black River,
« the South Fork including the Net River, and for
» the entire system.

ESSA Technologies Ltd.
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Barriers,
Stream
Configuration
& Stream
Barrier Activity

No chemical treatment options have been defined for the main stem alone,
since this portion of the river is only treated in conjunction with one of the
other two reaches. The simulation model within the LCSS keeps track of
individual lamprey populations within each of the three reaches. When
needed, the user can select a chemical treatment option which affects the
desired reaches.

The concept of Stream Configuration provides a way to represent the
change in in-stream lamprey populations when a new barrier to lamprey
movement is created. If you are using the LCSS simply to schedule
treatments for existing streams, with or without barriers, you should not
need to worry about stream configurations and stream barrier activity. If
you will be using the LCSS to explore the potential for new barrier sites,
you will need to understand these concepts.

In addition to individual reaches within a stream, the LCSS keeps track of
alternative stream configurations for each stream. An individual Stream
Configuration is simply a list of reaches which together define all areas of
the stream.

At least one stream configuration is defined for every stream in the LCSS
database. For the vast majority of streams, the stream configuration is
composed of only one reach which defines the "entire stream". For more
complex streams, the stream configuration is simply a list of the various
reaches that together describe the portions of the stream to which various
chemical treatment options may be applied.

For any stream on which a barrier may be created, a stream configuration
set has to be defined. If multiple barrier locations are to be explored,
additional stream configurations may be defined as needed.

Using the example of the Nemadji River, the basic stream configuration
for the river includes the Black River, the South Fork, and the main stem.
If a barrier were to be placed to prevent lamprey access to a part of the
system, a second stream configuration might be required, depending on the
placement of the barrier. If the barrier were placed at the confluence of
either the Black River or South Fork with the main stem, a new stream
configuration would not need to be defined even though access to one of the
reaches had been barred. Although access to a part of the river system had
changed, the overall structure of the river system remains the same.

If, however, the barrier was located along the main stem of the system part
way between the two major tributaries a second stream configuration would

2-5 ESSA Technologies Ltd.
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be defined for the system. Two new reaches would be described: one for

Treatment
Windows

the portion of the main stem of the river below the barrier and another for
the portion of the main stem above the barrier. When using the new stream
configuration definition for the stream, the LCSS simulation model will
separately track the development of lamprey populations in these two areas.
Additionally, new chemical options will need to be defined for any
treatments scheduled following barrier construction. This may be done by
modifying the chemical treatment options originally provided in the LCSS
database. LCSS will only simulate one stream configuration for any single
run. To simulate a presence or absence of barriers, we need to apply the
concept of Stream Barrier Activity.

Stream barrier activities specify different in-stream spawner allocations.
Each stream must have at least one stream barrier activity.

For streams that do have barriers, multiple stream barrier activities may be
defined to specify the spawner allocation under different barrier operating
conditions. At least two stream barrier activities should be defined for each
barrier stream, one representing the spawner allocations to each stream
reach in the "no barrier" (pre-barrier) condition and a second representing
the spawner allocations when the barrier is operational. Additional stream
barrier activities may be defined if needed to describe other situations (e.g.,
partial barrier failure, multiple barriers, etc.).

LCSS also takes into account temporal structure within the treaiment
season. While the underlying model functions on an annual time-step, the
model can simulate effects of treating streams at different times in the
season.

The flow characteristics of streams, seasonal patterns in stream biota, and
the logistics of applying chemical lampricide treatments are such that for
many streams, treatments are more effective at certain times of the year.
For example, it may be desirable to avoid times when environmental
damage to non-target species could occur, to avoid conflicts with
recreational users, or to avoid periods of high water flow.

Such differences are accounted for within the LCSS by designating a
specific treatment window to each chemical option. The date range for the
treatment window is a specific attribute of each chemical option and the
corresponding window is designated as being a preferred (P), acceptable
(A), or not acceptable (N). The effectiveness of a treatment on different
age classes of ammocetes can be specified for these windows. The amount
of chemical required and the costs associated with each window can also be

ESSA Technologies Ltd.
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defined. Whenever possible, users should avoid scheduling treatments
within negative treatment windows.
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LCSS Functions

Major LCSS
functions

3.0 Overview of LCSS Functions

This section provides a brief overview of the major functions of LCSS and
describes the general process that should be followed when using the
system.

LCSS is made up of three major components:

1) The LCSS program. This provides an interactive interface for inputting

the data that is required to define a proposed treatment schedule. Using
its built-in simulation model of lamprey population dynamics, the
system estimates the effect of the schedule on lamprey populations;

2) A set of standard databases. These contain the details of the stream

inventory, standard chemical treatment options for each stream reach,
definitions of the standard budget and crew resources available for
carrying out the treatment program. The databases also contain the
output variables from the simulation model; and

3) A relational database management system. This provides data

management functions to LCSS, and allows users to access database
review and reporting functions.

LCSS can be used to:

rank streams on the basis of the potential effect of treatments on stream
transformer production;

interactively modify control schedule treatments for developing short-
term control program (1 - 5 year) plans;

simulate the effects of barriers, traps and sterile male release on
lamprey populations, either separately or in concert with chemical
treatments;

run long-term (e.g. 50 year) scenarios of alternative lamprey control
programs that select chemical treatment options based on user-specified
stream selection criteria and logistical constraints imposed by resource
availability (chemicals, people, budgetary);

manage the retention of control program scenarios for subsequent input
to Economic Injury Level (EIL) analyses, graphical inspection of
relative performance, and/or numerical analysis;

3-1 ESSA Technologies Ltd.
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LCSS
Scenarios

+ generate standard reports of control program plans, review system
generated indicators of lamprey population status;

« explore the behaviour of the simulation models used by LCSS to assess
the implications of alternative assumptions about lamprey population
dynamics and treatment effects; and,

+ manage scenarios and keep track of planning activities undertaken with
the system.

The ability to explore the effects of alternative selection criteria and the
implications of modifications to short-term control plans will assist in the
long-term identification of preferred control plans that are consistent with
maintaining lamprey populations at EIL abundance.

A scenario refers to the data needed to specify the conditions that will be
simulated by a single simulation analysis made with LCSS. A scenario
includes the following types of data:

+ the starting conditions of lamprey populations (for all basins, streams,
and reaches to be simulated);

« the available budget and treatment resources (e.g. crews); and

« detailed descriptions of the control treatments that are to be simulated
by LCSS.

LCSS facilitates the process of defining a scenario by allowing the user to
modify standard default options. Users can also maintain and carry forward
variable-length scenarios of sea lamprey control programs for the Great
Lakes basin. Results of scenarios can be evaluated against recent
assessment data and parameter adjustments can then be made to improve
the accuracy of these predictions.

LCSS simulates the following control methods for developing control plans
Or scenarios:

TFM

TFM bars

Bayer - wettable powder

Bayer - granular

Traps (normally but not necessarily limited to assessment activities)
Barriers - with or without traps

Sterile Male Release Technique (SMRT).

N A=

ESSA Technologies Ltd.
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LCSS Functions

Default Scenario

Modifying
Scenarios

Barriers

Alternative control techniques such as chemical treatments, traps, barriers
and SMRT can be designated either individually or in combination. The
databases contain default chemical treatments for any stream or part
thereof. These chemical treatments can be modified to reflect the details of
actual treatments as applied to meet the specific environmental conditions
encountered in the field.

When a new scenario is created, the starting data are provided by the
default scenario databases. The default scenario includes the starting
conditions (i.e. 1957) for lamprey in all basins, streams and reaches to be
simulated; the available budget and treatment resources; and detailed
descriptions of the control treatments to be simulated by LCSS. The 4 most
current years population are included. The default scenario can be used to
generate a complete history (use the Long-term run function and select
scheduled treatments) or to do future simulations starting with the current
year.

If the scenario is to simulate conditions which are not reflected in the
system-standard input database, users must describe the new scenario
before running the model. The following must be taken into account before
developing a schedule for chemical treatments:

« any known, anticipated or hypothesized changes in barrier status
(operational or not) including the planned implementation schedule for
new barriers (within the calculation horizon);

- any modifications, known or anticipated, to the placement of traps in
streams and operation of traps associated with barriers;

- any known, anticipated or hypothesized changes to the plans for SMRT
during the time frame of the scenario; and

« the anticipated control program budget and resources available for
conducting the chemical control program.

Users can describe the specific details of the new scenario using the
Scenario Description option under the Edit Menu.

Barrier creation and SMRT are a minor part of the current sea lamprey
control program in the Great Lakes basin. Unlike lampricide control,
ranking streams for the application of these methods is done outside of the
current version of LCSS. However, LCSS can predict the state of larval
lamprey populations in a given stream and the effect of barriers or SMRT

3-3 ESSA Technologies Ltd.
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Sterile Male
Release
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applications. In this way, future scenarios of barrier construction and
SMRT can be evaluated in terms of their effects on the ongoing chemical
control program.

Barrier simulations essentially prevent sea lamprey from accessing a part
or all of the stream, thus reducing the effective lamprey habitat and
lowering the stream's lamprey productivity and chemical treatment priority
(rank). Since some barriers may occasionally be breached, LCSS has the
capability of simulating upstream populations as necessary.

Specifying the barrier placement and activity scenario requires the user to
identify which streams/reaches contain barriers and the proportion of
habitat accessible to lamprey when the barrier is "operational”. In addition,
the user may specify temporal changes in barrier activity for each year
within the time-frame of the scenario.

LCSS's simulation of SMRT acts to decrease the spawning success in the
stream, which may lower the stream's priority (rank) for chemical
treatment. For each stream to be treated with SMRT, either the actual
number of sterile males (to be/actually) released or the release rate (number
released relative to natural males) must be specified. Streams that have been
designated for SMRT may also be scheduled for chemical treatment.

One of the first steps in using LCSS is to enter the available resources, the
resource costs, and budgets for the current year and the years within the
calculation horizon. Available resources can be presented for the overall
program or its subset.

Using the resource requirements for individual stream treatments, the total
resource requirements can be estimated for predicted levels of lamprey
reduction.

Before scheduling streams for treatment, users must specify which criteria
should be used by LCSS to estimate the relative importance of applying
treatments to each stream. The criteria available for ranking streams for
applying chemical treatment in any year are:

1. maximum effect on lamprey: the predicted number of future
transformers killed by the lampricide treatment (large number killed
= high rank).

2. efficiency (benefit/cost) of lamprey reduction: the number of future
transformers killed per unit cost (large benefit/cost = high rank).

ESSA Technologies Ltd.

3-4



LCSS: User Guide

LCSS Functions

Defining the
Treatment
Schedule

Costing Control
Program

3. reduction in economic "damage" to the fish community: (value of lake
trout * estimated lake trout mortality attributable to lamprey predation
attributable to the stream): takes into account the potential damage to
the lake trout stocks as a result of parasitic phase lamprey. This
criterion is analogous to the maximum effect criterion of effects on
lamprey (high damage/stream = high rank).

4. efficiency (benefit/cost) of damage reduction: equivalent to criterion (2)
except measured in terms of the indirect (but primarily sought) impact
on the fish community rather than the direct impact on lamprey (high
damage/treatment cost = high rank).

5. environmental risk/damage: this incorporates those costs associated
with the effect of the treatment on non-target species and the costs of
remediation. These costs are added to the costs if the treatment,
increasing the overall cost and lowering the rank. This option can only
be used in conjunction with the "benefit" criteria (points 2 and 4
above).

You should always check the criterion setting before starting to define a
treatment schedule since the selected criteria will determine the order in
which streams are listed (ranked) in the treatment scheduler.

Once users have modified the scenario according to the general procedure
described above, they must develop a treatment schedule. LCSS allows
users to interactively schedule treatments by displaying the list of streams
to be treated in priority order (as defined by the selected ranking criteria),
and a monthly calendar on which stream treatments can be scheduled.

Treatments are scheduled for individual crews and a different calendar is
maintained for each treatment crew defined in the system database.

Note: in the current version, the displayed stream list includes all streams
in priority order, not just those which would normally be treated by a given
crew. Therefore when working with the system you may find it helpful to
keep a reference list of streams which would normally be treated by the
different crews.

Users can create a treatment schedule, or they can conduct an automatic
scheduling. When carrying out an automatic schedule, LCSS calculates a
"running" budget. The cost of the scheduled program is determined by
summing the default costs for the individual stream treatments from the
central database. The resource requirements and associated costs are steam-
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specific. Travel costs to the deployment site are considered separately from
treatment costs. Depending on how the budget was structured, the cost of
each treatment is subtracted from the total budget or from individual Great
Lake budgets. Once all the available money is spent, no more streams will
be allocated for the particular lake.

LCSS may be used to modify a control program, including those that are
under way, as a response to unexpected logistical or climatic factors that
disrupt the control schedule. Users can edit a treatment schedule to specify
changes to the control program with regard to either the selection of
streams for treatment or to their placement within the treatment schedule.
This permits system users to explore the implications of alternative
treatment selections.

In addition to using the LCSS to develop and adjust short-term lamprey
control plans, it can also be used to generate long-term control scenarios.
Users can compare alternative treatment selection criteria for their long-
term performance and can generate the output needed to establish the form
of the Lamprey Abundance (L) vs Control, curve for input to EIL
estimation procedures. The results from any one scenario are used to define
only one point on this curve which describes the relationship between
lamprey abundance and a range of control program budgets (costs).

Developing the L vs Control,, relationship for subsequent determination
of an EIL for any basin in the context of whole basin logistical and
resource constraints requires simulating the effect control strategies over a
series of resource (cost) levels. Scenarios must be run for a sufficiently
long-term horizon so that an equilibrium level of lamprey abundance may
be determined from the last few years (e.g. 5 - 10) of the simulation. The
estimates of equilibrium abundance of lamprey within any basin, and the
costs attributable to the basin can then be used to define L vs Control.

The process of running long-term simulations is essentially the same as that
described above for using the LCSS to develop short-term program plans.

Instead of using the LCSS to define or edit a detailed treatment program
(including logistical constraints of crew availability and timing) you can use
the Quick Schedule option under the Edit Menu to create a list of streams
for treatment in each year of the scenario. This needs to be done only if
you want to predefine the streams to be treated. In a longterm scheduled
scenario, only the streams specified in the scheduler or Quick Schedule
feature will be treated. The treatments applied are those selected for the
streams or the defaults.
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Alternately, you may use the LCSS to run a longterm Resource Limited
scenario. When a Resource Limited scenario is run, the LCSS will
automatically schedule streams for treatment during each year of the
scenario run according to their treatment priority until resources are
depleted.
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4.0 LCSS User Interface

The IMSL Decision Support System is composed of two major elements:
the Lamprey Control Selection System (LCSS) and the IMSL Database
Access Module. This section describes the user interface of LCSS and
provides an overview of all of the menu commands and associated
functions. The IMSL Database Access Module Interface is described in
Appendix C.

Throughout this Section, certain formatting conventions have been used.
These are:

Example Description

Stream Configuration screen name

Reach field name

Stream list, table, column

AddConf command button

Lamprey Allocation cross-reference to other sections
m  To edit reach parameters: identifies "how-to" sections

Treat Specifies if the stream will be  indented lists of field descriptions
considered for treatment.

The Main Menu gives you access to all parts of LCSS. Each of the
submenus of the Main Menu and associated functions are described below.

Lamprey Control Selection System
File Edit LongTerm Database Options Help

o

The File Menu contains the scenario and data file

. Eile
management options.
hag ptio New Scenario DB

Select Scenario DB
To create a new scenario based upon the default New Results DB

scenario, select New Scenario DB. Select Scenario Select Results DB

Scenario Management

Exit

4-1 ESSA Technologies Ltd.



LCSS User Interface

LCSS: User Guide

New Scenario
DB

Select Scenario
DB

DB lets you choose from one of the existing scenarios.

The New Results DB and Select Results DB are used to specify which
databases will contain the results of the simulations.

Use the Scenario Management option to delete scenarios or results database
files. (Note: this function has not yet been implemented.)

The Exit option quits the LCSS program.
Each of these options is described in detail below.

The New Scenario DB option can be used to make a copy of the default
scenario database. The default scenario includes the starting conditions for
lamprey in all basins, streams and reaches to be simulated; the available
budget and treatment resources; and detailed descriptions of the control
treatments. You can use the default scenario database as a template from
which to create a new set of conditions and parameters.

Create New Scenario DB
New Scenario DB Name: §_____— |MDB [X Create new results DB

New Results DB Name: E:}MDB

I

|

You are prompted to enter the name of the new scenario and results
databases. Enter up to seven characters in the appropriate fields. When the
"Create new results DB" box is checked, the name you entered for the new
scenario database is also entered as the results database name, except for
the prefix "S" or "R".

The Select Scenario DB option allows you to choose an existing scenario
database for use in the simulation.

Select Scenario Database

File Name: Directosies:
e
e\
= imal
4 helpfile
List Files of Yype: Drives:
[Scenafio Files (s*.mdb} !}J [ c: ms-dos 5 I}J
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This option creates a new database in which to store the results of the
simulation. Note that the Results Databases all begin with the prefix "R"
to distinguish them from the Scenario Databases that begin with the prefix
HS" .

Create New Resuits DB

Enter the name of the new database and press OK.

Select Results DB lets you choose an existing database to contain the results
of your simulation.

Select Results Database

File Name: Directories:
cima
rhist.mdb e\
£ imst
{33 heipfile
List Files of Jype: Driyes:
lﬂesdl: Files {r*.mdb} [ il c: msdos 5§ E

Press Exit to close the program.

The Edit Menu allows the parameters of the current scenario to be
modified. A scenario represents a set of conditions being simulated by the
model, and includes parameter values, management options and results.
Scenarios include the starting conditions for lamprey in all basins, streams
and reaches to be simulated; the available budget and treatment resources;
and detailed descriptions of the control treatments to be simulated by
LCSS.

You are not required to specify all values, as a series of default values
exist. However, you can modify and manipulate the default values for
existing scenarios by using the options available under the Edit Menu.
Each option is described in detail in this section.
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Selecting the Scenario Description option allows you to modify the scenario

description. Ed

Scenario Description
Budget and Hesources
Ranking Criteria
Treatment Schedule
Quick Schedule

Stream Setup
Biological Parameters
Lamprey Allocation
Traps

SMRT

Basin Population
Stream Population

The Budget and Resources option is used to
enter and modify the budgets, resources, and
resource costs for all of the years within the
calculation horizon.

The Ranking Criteria option lets you select
which ranking criterion will be applied when
streams are ranked for treatment.

Treatment Schedule ranks the streams and helps
create treatment schedules.

Quick Schedule is used to quickly select streams for treatment without
taking into account logistics or exact chemical details (default chemical
options are used).

Stream Setup provides information about configurations, barriers and
activities for each stream in the database.

The Biological Parameters option is used to modify the lamprey model
parameters.

Lamprey Allocation is used to allocate spawners from basins to streams and
to allocate transformers from streams to basins.

The Traps option sets the traps for streams and reaches.
SMRT allows definition of the release of sterile males into streams.

The Basin Population screen defines the number of lamprey in each basin
of the currently selected lake.

The Stream Population screen defines the survival, density and length
parameters of lamprey ammocetes in selected streams and reaches.

The Scenario Description screen allows you to describe the content of the
currently selected scenario.
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Scenario Description

Scenario Hame: [Res Limited 1934-97 from base hist |

Operator Name:  [Gavin - GLFC .

]

Scenario Description:

successful qompletion - with debt error

Addition of 1994-97 resource mited tun to base - with budget = 0- first =
Crandard hstorcal

base This inchud

all of the GLFC teatment

fuded in

history. Please note however, that the t

the database does NOT use all of the specific detail of the historical
brvmiend treabments treatment The t .

.

t histoty i

fuded in thi

t history i

In addition to the explicit option under the Edit Menu, this screen appears
whenever the nature of the current scenario is likely to have been changed.
For example, when a new scenario is created (New Scenario, Save Scenario
As... options in the File Menu) and when a treatment schedule is altered
(OK command button in Treatment Schedule) the Scenario Description

screen will activate.

The Budget and Resources screen, accessed from the Edit Menu, is used
to enter and modify the budgets, resources, and resource costs for any year.
Resources include funds, crews, chemicals, barriers, SMRT and traps.
Upon activation, this screen gives the option to recalculate trap costs. This
needs to be done only when trap costs have been changed by the user (see

Traps section on pg. 4-37).

Budget and Resources

Admin/Fixed Year : BdgtGrp [l €§1395: 1 [F] M|

Ext. Exp. W Year] |Delyesi

Assessment Prev. Year Suip/Debt

RtD Current Year Budget

Crew Cost e rewe

Barrier Cost Avg. Operating Cost  [$10.000.00 Raiiiois]

SMRT Cost SMRT ProduclionE:::) Cost/Unit

Trap Cost $0.00

Chemical Controls: Pg;‘chase ﬁ‘::: I'[‘ltng] [PZ:I?:: 8[:g] Eﬁiﬂﬁ:ﬁ “
TFM {s0.00 [o {100 [Fied]$55.00 |$0.00 |
TFM Bars  [$0.00 [o ] {MoLim] s40.00 [s0.00 |
BayerWP  [50.00 [o [50 |Fixed]$92.40 [s0.00 |
Bager-Gran (40,00 o | Matim{$1540 [$0.00 |

Program Cost: lsg_m] Available {SUAUU E;?:?.rigglg]ft

[] Keep year's budget between runs Balance  [$0.00 | 30.00 ]
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This screen contains an extensive amount of data. Generally, the fields in
the top third of the screen represent known program costs plus information
about the budget year and total budget; the middle third of the screen
contains information on the costs of crews, barriers, SMRT, and traps; and
the bottom third of the screen displays details about the chemical control
program. These options are discussed in detail below.

The option box at the bottom of the screen, Keep year’s budget berween
runs allows you to set user-entered budgets. As the simulation progresses,
the system uses the latest Keep budget as a default.

g In future versions of the program, different organizational units or
institutional groups will be able to set unique budgets. This option
will be specified through the Budget Group category. At the present
time, LCSS uses a single budget for all of the Great Lakes.

To enter a new budget:

1. Choose the year you wish to serve as a template.

2. Click on the New Year button and enter the new values. Modify the
values in the available fields as necessary (descriptions below).

3. Click OK to leave the screen and return to the Main Menu.

You may want to delete an existing budget for a particular year. Select Del
Year and specify whether you want to delete budget information only, or
whether you want to delete all information on the budget, crews, and
schedule that was entered for the selected year. If you choose to delete
only budget information, crew and schedule data will be stored by the
system until a new budget is entered or generated for that year.

LCSS holds detailed information only for budgets directly related to
treating lamprey. However, additional fields are provided that allow users
to enter other budget details. These are default administrative and fixed
costs (Admin/Fixed), extraneous expenses (Ext. Exp), assessment cOSts
(Assessment) and research and development costs (R&D). These can be
modified by simply typing in the new amounts.

[ Barrier extraneous expenses can be specified by selecting the
Barriers button which activates the Stream Barriers screen. From
there, select extraneous expenses (Ex. Expenses button) to access
the Extraneous Stream Barrier Costs screen.

The two fields immediately below the year field display the surplus or debt
(specified as negative) from the previous year along with the current year's
budget. In the first year of the program, you will need to input the previous
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year's surplus or debt; in subsequent years, you can choose to have this
value calculated automatically by flagging an option in the General Options
screen (in Options from the Main Menu).

Once you have entered (or edited) the known program costs for the current
year's budget, you will need to provide the system with further information
about the crews and the control program for barriers, sterile male release
and traps. Each of these options is discussed below.

Based on the information that you provide in the Budget and Resources
screen and the current treatment schedule, the system will calculate and
display the new total cost when you click on the Recalculate button.

The number value in the Crew Cost field is calculated based on data
provided about crews in the Crew Details screen. You can access this
screen by selecting the Crews button in the Budget and Resources screen.

Crew Details

Crew Name: [Alpha ] Size: E:l
Base Camp: M0 | Standard Trip Length:

Annual Operating Cost: {$253 707.70

Annual Crew Salaty: [¢512 576.70 | Overtime Cost: .

{eg. ¥ of daily salary
Available From: [471796 ] Yo [or31496 |

Days Available: [ 214 Portion of time for treatments:

Select a crew:

The Crew Details screen displays default information for each crew. To
modify crew data, start by selecting the crew that you want to edit by using
the scroll arrows at the bottom of the screen. The crew name is displayed
at the top of the screen, along with data for that particular crew. Enter or
modify data on the crew name, size, base camp, standard trip length,
annual operating cost, annual crew salary, overtime cost, and availability
dates. Based on this information, the system will calculate the total crew
cost for the Budget and Resources screen. When done, press Save to save
your changes and retain the Crew Details screen. Press OK to save your
changes and return to the Budget and Resources screen.

To add a crew, press Add Crew. Enter data into all of the fields. To
delete a crew, select the crew that you want to delete. Press Delete Crew.
All information on the currently selected crew will be deleted.

LCSS automatically calculates the total cost for the barrier program
according to the current barrier schedule. You can review individual barrier
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costs by selecting the Barriers button on the Budget and Resources screen,
which accesses the Stream Barriers screen (see pg. 4-21).

The Sterile Male Release Technique (SMRT) cost is calculated according
to the parameters provided in the SMRT screens (see pg. 4-41) and the
current year’s treatment schedule, along with the unit cost per sterile male
provided on the main Budget and Resources screen.

The Trap Cost is calculated according to the current schedule. Choose the
Traps button to bring up the Default Trap Placement screen and alter the
number, type and location of the traps as necessary.

A full discussion of the options available on the set of screens associated
with Default Trap Placement is given later in this chapter on page 4-38 (see
also pg. 5-16, 17).

Chemical treatment is an important component of the lamprey control. The
fields on the lower third of the Budget and Resources screen allow you to
establish a chemical purchasing strategy.

The LCSS considers four chemical controls: TFM, TFM bars, Bayer
(Wettable Powder), and Bayer (Granular). For each chemical, data are
displayed on Purchase Cost, Amount Used, Purchase Ceiling, Purchase
Cost/Unit, and Total Cost. The first two fields, Purchase Cost and Amount
Used are calculated by the system based on the treatment schedule.

The chemical purchase strategy can be changed by clicking on the button
displaying the current strategy (e.g., NoLim). As you click on this button,
other strategies are displayed and the Purchase Ceiling field will become
visible. The four purchase strategies are described below: ‘

Fixed The amount of chemical specified in the Purchase Ceiling column
is purchased regardiess of how much will be used according to the
schedule. If the purchase does not cover the current year's needs,
the difference will be made up from the chemical stocks available,
or fewer potential streams will be treated. If there is extra chemical
left at the end of the year's control program, the remainder will be
added to the chemical stock for use in subsequent years.

Max This limits the amount of chemical available for purchase. However,
the money assigned to purchasing chemicals can be used, if
needed, for other costs incurred during the year, such as
purchasing other chemicals, paying for crews, overtime etc. If less
chemical is required for the year's program, less is purchased. If
more is required, the difference is made up from the stocks.
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Min The amount shown in the Purchase Ceiling field is the minimum
amount that can be purchased. If the schedule specifies more than
the minimum and the funds are available, additional chemical
purchases will be scheduled. Any excess amount will be added to
the next year's stock.

NolL.im No limit is placed on chemical availability. The only limiting factor is
the availability of funds.

> The chemical purchase strategy is very important when using the
automatically scheduled treatments. For example, when you are
conducting a resource limited or automatic schedule Long-Term
Run, the amounts you indicate in the chemical control fields will be
used as guides to determine treatment possibilities. When you are
creating a manual schedule, however, these settings are ignored.

The Chemical Stock Details screen can be activates by clicking on the
Chem. Stock command button on the Budget and Resources screen. It
allows the user to define the availability and cost of chemicals. Chemical
stocks cover any shortfall or absorb any excess chemical in the treatment
schedule. When extra chemical is added to the stock, the purchase price
is blended into the stock cost/unit by averaging weighted by relative amount
of stock and new chemical.

Chemical Stock Details

Stock levels reflect a state at the beginning of 1996
Current Stock Price Stock
Stock {kg) Cost/Unit Same Fust
TFM [500 I[s5500 | B K
TFM Bars  [100 Jss000 | ® B
Bayer-WP  [100 [[$89240 | B &
Bayer-Gran. [100 [sis40 | B X

Each field displayed on this screen is described below:

Current Stock Represents the amount of chemical that is currently available in
stock.

StockCost/Unit Indicates the average cost per unit of stock. This value may
change as chemicals are put into stock at different purchase prices.

Price Same  When this option is selected, the system ignores the calculated
stock cost per unit and uses the purchase cost per unit for that year
to calculate stock cost. In effect, this calculates the replacement
cost for the chemical used for treatment. This cost will be added to
the current year's total program cost, but will not be contained in the
year's expenditure.
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Stock First  When this option is selected, the system uses the chemicals in
stock before making use of recently purchased chemicals. The
amount of chemicals in stock will be updated from year to year
when the update budget/stocks option is flagged in the General
Options screen under the Options Menu.

[ You can set both the Current Stock and the Stock Cost/Unit values
and keep them at those values. To do so, you need to turn off the
automatic stock update command in the General Options screen.
Otherwise, the system will overwrite the entered value.

Once you have entered (or modified) all of the program cost fields, as well
as details about crews, barriers, sterile male release, traps, and the
chemical control program, you are ready to calculate the total program
costs for the year.

Press Recalculate. The total program costs will be calculated. Note that the
fields at the very bottom of the Budget and Resources screen display the
Total Program Cost and the Program Cost Including Stock. The Total
Program Cost represents the amount of money needed for the current year.
This does not include the cost of the stock used (since it was not necessary
to buy it). The stock cost is included in the Program Cost Including Stock.
This allows better tracking of the use of resources from year to year.

The total amount of money available for the selected year, determined by
adding the previous year's surplus or debt to the current year's budget, is
represented in the Available field. The surplus or debt for the current year
is displayed in the Balance field.

[ In order for the system to calculate the total SMRT cost, you must
conduct a simulation run before calculating the budget. '

Ranking Criteria establishes which criterion will be applied when ranking
streams for treatment. Before you schedule streams for treatment, you need
to specify the criterion that should be used to estimate the relative
importance of applying treatments to each stream.

ESSA Technologies Ltd.
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Ranking Criteria
Select the ranking criterion

Transformers

Fish

Effect Beneft  [X(Envirgnmental Damage!
S etoction Ciiterion D

Lamprey killed per unit cost

Clicking on the appropriate square in the grid selects the ranking criterion,
which is described in the box at the bottom of the screen. Each ranking
criterion is described below: :

Transformers-Effect Streams are ranked according to the maximum effect on
lamprey, i.e. the number of future transformers killed per treatment.
it does not take into account the cost of the treatment.

Transformers-Benefit Streams are ranked according to the benefit/cost ratio of
lamprey reduction, i.e. the number of future transformers killed per
unit cost.

Fish-Effect Streams are ranked according to the maximum reduction in
damage to the fish community (maximum number of fish saved).
(Note: the fish model has not yet been linked to the lamprey model,
so this ranking criterion is not supported by the Treatment
Schedule.)

Fish-Benefit Streams are ranked according to the benefit/cost of damage
reduction (most valuable stocks saved for the least cost). (Note: the
fish model has not yet been linked to the lamprey model, so this
ranking criterion is not supported by the Treatment Schedule.)

When either Transformers-Benefit or Fish-Benefit is selected, - the
Environmental Damage checkbox is displayed. By checking the box, the
costs of potential environmental damage are incorporated into the ranking
criterion. Options with lower probabilities or costs of environmental
damage and/or mitigation will be given a higher rank than other options.
However, since environmental damage/mitigation adds to the cost of
treatment, this option is only available when you have chosen to rank
streams using benefits as the central criteria. The values for environmental
damage/mitigation can be modified on the Chemical Option Details screen
(see pg. 4-26).

The Treatment Schedule screen is one of the most important parts of LCSS.
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It allows you to interactively create a treatment schedule for all the years
within the calculation horizon.

The screen has two major components: the graphical representation of the
current month and the list of ranked streams. The features of this screen

are described below.

Treatment Schedule

(S 10634) FISHCR [1.131]
{S 10611} BAD RIV [0.
{5 10122) LAUGHIN

{5 509) BLACK STU
S 305) P

L3 {15 10295] ONTONA
{S 10115) ROCK BRI
(5 10712) NEMADJI
(S 10150) CARP Rl

(S 2) WEST DAVIG
(S 56) PANCAKE
{5 10420) MONTRE

{S 572] KAMINISTI
{S 10660) SAND Bl
{S 10110) AU TRAI

Curent Crew:

[] Show Treatment Windows

[Alpha

Month, Year

Calendar

The current month and year can be selected by clicking the "arrow"
buttons above the calendar. As you move through the years in this
screen, LCSS will give you the opportunity to update the budget (to
accommodate changes in the schedule from year to year) and
population age structure.

Whenever applicable, the calendar will display scheduled events
(treatments or user-defined events) for the currently selected year.
The total time required to undertake the scheduled event (including
travel to and from the deployment site) is represented graphically
on the calendar by means of a coloured rectangle. Clicking once on
an event displays the deployment site for the event (displayed
below the ranked list). Double-clicking on the scheduled event
invokes the Trip Management screen (pg. 4-14), where you can
view and modify details of a trip's event.

Show Treatment Windows Each treatment option is assigned one of three

treatment window types, i.e., preferred, acceptable or not
acceptable (see Window, pg. 4-27). Future versions of LCSS will
be able to show the assigned treatment window in the calendar
when you check the Show Treatment Windows box (bottom left
corner of the Treatment Schedule screen).

Ranked Streams List This field displays a list of untreated streams (uniess you

have selected the Keep option in the Trip Management screen - see
the Trip Management section, pg. 4-14). Each entry on the ranked
streams list shows the lake (represented by the first initial), the

ESSA Technologies Ltd.
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stream number, the stream name, and its rank value. The streams
are listed in descending order according to ranking value. Clicking
once on a stream in this list updates the Deployment Site field.
Ranking scores for each stream’s default treatment are displayed
in the Stream Info screen, which is invoked by double-clicking on a

stream name.

= Stream Info
Ranking scores for the stream’s defauit treatment:

Year: 1996 Lake: § Stream: 10051
Treatment Cost {$}:
Environmental Damage cost [$): E::]
Effect transformers killed):
Benefit (trans. killed/$): Iiﬁ!ﬁill..
Benefit including Envi tal Damage: 873

Fish Effect {number of fish saved):
Fish Benefit {value of fish saved):
Fish Benefit including Envi

All, Base, Crew, Site, Crew@Site You can limit the list of streams in the Ranked
Streams List. You can choose to display all of the streams in the
Great Lakes basin (All); those corresponding to a given crew's base
(Base); those matching only the selected crew's size (Crew); those
that can only be treated from the specified deployment site (Site);
or a combination of a crew of a certain size at a specified site

(Crew@Site).

03> Remember, if you want to select a new ranking criterion, use the
Ranking Criteria option in the Edit Menu. If you have entered new
parameters or modified the scenario since you last selected a
ranking criterion, you should press New before you begin to create
a treatment schedule. This will rebuild the list of ranked streams.

To schedule streams for treatment:

1. Using the arrow keys on either side of the year and month fields, select
the year and the month for which you wish to schedule treatments. A
calendar is automatically displayed for the selected month, along with

a list of streams ranked in priority for treatment.

2. Customize the Ranked Stream List using All, Base, Crew, Site or

Crew@Site options described above.

3. Select the name of the stream you wish to schedule for treatment and
drag it to the desired start date. (Note that this action will remove the
selected stream from the ranked streams list unless you have selected the
Keep option in the Trip Management screen, pg. 4-14) If you wish to
schedule adjacent treatments, drop the second stream on top of the first.

4-13
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Other treatment
schedule options

Trip Management

You will be asked to confirm whether you wish to join the two streams
into a single trip.

4. If there is a need to modify treatment attributes (dates, travel time,
chemical options, etc.), double-click on the scheduled treatment event
displayed on the calendar to invoke the Trip Management screen.

There are several other options in the central Treatment Schedule screen,
accessed by selecting the buttons along the right side of the screen. Each
button is described below:

New

Budget

StreamAct
SMRT

GenAll

User

Summary

Sort

OK

Removes all events from the schedule for the current year and
recalculates the current rank list.

Accesses the Budget and Resources screen, letting you view
and/or modify the budget for any year.

Brings up the Stream Barrier Activity screen.
Accesses SMRT options.

In future versions of LCSS, this option will use the built-in expert
system to automatically create a schedule for the current year.

Allows you to create user-defined events. Enter the event name and
its duration in the appropriate fields. Each user-defined event is
stored in a database and can be used for other crews or other
schedules. To schedule a user-defined event for treatment, click
anywhere on the white space of the User Event screen, and,
holding down the mouse button, drag the event to the calendar and
drop it on the appropriate starting day.

Produces statistics about the current schedule. These include:
projected future transformers killed, mean cost per transformer
killed, crew time utilization, cumulative cost, unused budget,
resources used (TFM, Bayer, Sterile Males), and others. Some of
this information will also be available from the Budget and
Resources screen.

Allows you to sort lakes and streams according to their rank (see
Ranking Criteria screen). In future versions of the program, users
will be able to sort by name and number as well as by rank.

Exits the screen.

The options displayed on the Trip Management screen are used to edit the
attributes of a scheduled treatment event.

ESSA Technologies Ltd.
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Trip Management
d Teip Duration:
Travet Overtime: r_ﬁ:}

i
Event Descrip!

E vent Descnp tion

(S 10051] LITTCET {6/3/96 6 8 |8 i} TH Tue |Faise

Gtart Date [Duttn {To  [From [Overi{DSite |Keep [Eval

This screen, activated by double-clicking on a scheduled event in the
Treatment Schedule screen, displays details about each event in a trip. You
can modify all of the values in this table except the three summary fields
Trip Duration, Travel and Overtime.

Crews

Add

Remove

Trip Duration

Travel

Overtime

The Crews field provides lists of all crews participating in the trip.
Use Add and Remove command buttons to modify the list.

Click on Add to add a crew to the trip. This allows multiple crews
to treat a set of streams.

Remove a crew from the trip.

This is a calculated field indicating the total trip duration (sum of
durations of individual events plus travel time).

This field indicates the total time required for travel from the crew’s
base to the deployment site.

This field shows the time over the recommended trip duration (crew
specific). This value is used for calculations of total program cost.

Event Description This is the description used in the event box on the calendar.

Start Date
Duration

To, From

Overt
DSite

Keep

The start date of the event.
Event duration (in days).

Travel time to and from the deployment site. By default, this is
applied only for the first and last event in a trip.

# of days in the event that are overtime.

Deployment site.

This field is used to indicate whether the stream should be retained
in the Ranked Stream List on the Treatment Schedule. A value of

True retains the stream on the rank list, allowing you to treat the
stream on multiple occasions throughout the year. The default value
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Quick Schedule

Eval

Drop Event

Modify

of False removes the stream from the Ranked Stream List once it
has been scheduled for treatment.

This field offers users the opportunity to have the computer to
search for the best chemical option (see Long Term Menu, pg. 4-
45). A value of True instructs the system to re-evaluate and find
the chemical option that will treat all reaches with lamprey for
minimal cost. False indicates that the system will use the chemical
option entered by the user.

To remove an event from treatment, select the event and click on
the Drop Event button.

Clicking Modify accesses the Chemical Option Details screen (see
pg. 4-26) where you can edit values for the current treatment
program (or user-defined events).

Altering the order of treatment events is also possible, although it does
require some juggling. To rearrange the existing order of events, edit the
starting date of a given event. The system will automatically change the
starting dates of the other events in the trip to accommodate the new date.

In some cases, moving an event may be a multi-step process. For example,
to move an event to the front of the trip you must change the start date of
the first event to a later date (e.g. next day) and then move the desired
event to the front and modify the travel appropriately.

0> To make it easier to change the order of events in a trip, put
"dummy" user events as the first and the last event in a trip. When
you have changed the order, remove the "dummy" events. LCSS
will automatically move the start date of the first event up and add
the appropriate travel time at the beginning and the end of the trip.

g For further information about the Chemical Option Details screen,
please refer to page 4-26.

The Quick Schedule option provides an easy way to select streams for
treatment. It ignores the logistical constraints and uses the default chemical
options. All of the selected streams are placed on the calendar of a single
(first) crew starting on January 1 of the selected year.

ESSA Technologies Ltd.
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Quick Schedule

Unteated streams:

{0 76} BRONTE (R,
(0 120) CARRUTHERS CR.
{0 10060) CATFISH CR.

(0 148} COBOURG BR.

(0 161) COLBORNE CR.

Treated steams:
{0 60} ANCASTER CR.
(0 10059) SBUTTERFLY CR.
{0 10052) DEER CR.
(0 117} DUFFINS CR.
3{(0 10056) LITTLE SALMON B,

{0 10066] FISH CR (OSWEGORE
{0 145) GAGE CR. :

(0 154) GRAFTON CR.
{0 133} GRAHAM CR.
(0 10054) GRINDSTONE CR. B
{0 100) HUMBER R. :

{0 10048) LINDSEY CR.
{0 10050) LITTLE SANDY CR. [

m  To schedule streams for treatment:
1. Select the treatment year.
2. Select all of the untreated streams you want to transfer by clicking on
each with your mouse. Click on the right-pointing arrow to move the
stream(s) from the Untreated Streams list to the Treated Streams list.

m  To remove streams from treatment:
1. Select the treatment year.
2. Select all of the treated streams you want to remove from treatment.
Click on the left-pointing arrow to move the stream(s) from the Treated
Streams list to the Untreated Streams list.

> This option is most appropriately applied when you want to quickly
enter historical treatments for use in Scheduled Treatment-type long-

term rumns.

Stream Setup  This screen is a centre for defining physical characteristics of streams and
their "behaviour", including barriers and chemical options.

Stream Setup

Lake: Stream: Currently Simulated Stream Confi
E Single feach stream
H 10705 Stream with barrier
M [10018] ANKODOSH CREEK
3] [10104] ANNA RIVER
N | [10901] ARROWHEAD RIVER
{10110] AU TBAIN RIVER
{10611] BAD RIVER
[52] BATCHAWANA
[10090] BEAVER LAKE CREEK
[10027] BETSY RIVER
Sort Streams By: @ Name (U Number
Stieam Code: [ simulate [] Treat (] Default Chem. Opt .Only
Latitude: [::l State/Prov: [:::l Budget Gtoup:E:]
Claxs:‘g J @
Euﬁgmamﬂ [ Bowiers
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The Lake and Stream lists allow selection of a stream to be viewed or
modified. The list can be sorted by either the stream name or the stream
number. The sort order can be chosen under the stream list. The stream
selection made here is propagated through all of the screens accessible from
the Stream Setup screen. Similarly, stream selections made on other
screens will be reflected here.

The Currently Simulated Stream Configuration list displays all of the
currently defined physical representations of the selected stream. The one
currently highlighted is used in the simulation. For more detail on stream
configurations see the Stream Configuration section (pg. 4-19).

The Stream Setup screen also allows modification of the following
characteristics of streams:

Stream Code Code used in some of the other lamprey program documentation.

Simulate Specifies if the stream will be simulated in the next run. The
selection made here should be coordinated with lamprey allocation
between the basins and streams (see Lamprey Allocation section,
pg. 4-31).

Treat Specifies if the stream will be considered for treatment. Streams
not simulated cannot be selected for treatment.

Default Chem. Opt. Only Specifies if LCSS will re-evaluate the chemical option
used for the stream (see Long Term Menu, pg. 4-45).

Latitude, Longitude, State/Province, and Country Define the stream location.

Class Is used in calculations of static basin-to-stream lamprey allocations
(see Lamprey Allocation section, pg. 4-31).

Budget Group s currently unused and should always be set to 1.

The Stream Setup screen allows access to 3 other screens:

Configuration: allows definition of stream configurations (see Stream
Configuration section, pg. 4-19).

Barriers: allows definition of barriers (see Stream Barriers section,
pg. 4-21).
Activity: allows modification of stream "behaviour" (see Stream

Barrier Activity section, pg. 4-23).

[y At the present time, the simulate flag and the basin-to-stream
allocation are not implicitly linked. This means that to alter the
simulation status of a stream you must also modify the lamprey

ESSA Technologies Ltd.
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Stream
Configuration

allocation to and from the stream (see Lamprey Allocation section
pg. 4-31).

g Itis currently impossible to define new streams through the LCSS
interface. To define a new stream, use the native MS Access
interface to add a record to 2 tables: Stream and SimStream. Once
the records are there, the Stream Setup family of screens in LCSS
can be used to define the stream.

The Stream Configuration screen allows entry and modification of stream
configurations. This screen can be accessed by clicking on the
Configuration button in the Stream Setup screen.

Stream Configuration

Stream:
[110705] AMNICON RIVER ™
415|Single reach stream
| 4d5] Stream with barrier
Heach:
Heach| ReachName In DownStr
1 ENTIRE SYSTEM False
7 |BELOW NEW BAR.-OLD WEIR SITE True |2
3 |ABOVE NEW BAR.-OLD WEIR SITE Tue |2

A stream configuration is a definition of the physical layout of the stream.
It is composed of "reaches", non-overlapping sections of the stream acting
as homogenous units. The reaches are connected by defining a downstream
reach. The lowest single reach in a group should be defined to flow into
itself. A combination of reaches, a stream configuration, represents the
whole of the stream. A single reach may belong to multiple stream
configurations. A stream can have multiple alternate stream configurations,
although only one can be used in the course of a single simulation.

All of the stream configurations are listed in the Stream Configuration
table. The ID column in the table automatically generates unique identifiers
for stream configurations. The Description column provides short
descriptions of each configuration. New stream configurations can be
added using the Add Conf command button. Existing stream configurations
can be removed using the Del Conf button.

The Reach table lists all of the reaches defined for the stream for all of the
stream’s configurations. Reaches may overlap, although if they do they
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should not be included in the same stream configuration. The Reach
column uniquely identifies the reach within the stream, ReachName
provides a short description of the reach, the In column specifies if the
reach is included in the currently selected reach configuration (true = yes),
and the DownStr column specifies which of the other reaches within the
current stream configuration is downstream of the selected reach.

Reaches can be added in two ways. The Reach button opens a screen
where individual reaches can be added, removed, or modified (see below).
The Split Reach button opens a screen that divides the currently selected
reach into 2 or more sub-reaches.

Clicking on the Reach button in the Stream Configuration screen opens the
Physical Reach Parameters screen.

Physical Reach Parameters

Lake: E Stream: [10705 Reach: [ [] Lentic Reach
Reach Name  |ENTIRE SYSTEM . ]

Discharge {msm Discharge Std Dev [_’“_’:::]
Max. Length [km] Avg. Length [km)
Reach Width (m)

Prop. High Qual. EEZ: Prop. Med Qual.
T. Area (m2) Habitat Area (m2)

Comment: [ ]

This screen allows addition/deletion of reaches and modification of physical
reach parameters. The reaches for the current stream can be selected from
a drop down list. Parameters available for modification are:

Lentic Reach This field consists of a checkbox to indicate whether the current
reach is a lentic reach.

Reach Name A short description of the reach.

Discharge Mean annual flow (in cubic metres per second) at the lowest most
part of the reach.

Discharge Std Dev Standard deviation of the discharge within the year.
Max. Length  The total length (in kilometres) of the reach.
Avg. Length  The length of the reach (in kilometres) inhabited by lamprey.

Reach Width Width of the reach (in metres) at the lowest most part of the reach.

ESSA Technologies Ltd. 4-20



LCSS: User Guide

LCSS User Interface

Stream Barriers

Prop. High Qual. Proportion of the potential habitat area of high quality.

Prop. Med Qual. Proportion of the potential habitat area of medium quality.

T. Area

Habitat Area

Total reach area (usually Reach Width * Avg. Length) (in square
metres). This value can also be generated by clicking on the Calc
Area command button (see below).

High quality equivalent of the area (usually T. Area * (Prop. High
Qual + 0.2 * Prop. Med Qual.)) (in square metres). This value can
be generated by clicking on the Calc Area command button (see
below).

g It is important to ensure that the value set for Habitat Area is
greater than 0, otherwise the system will not perform its simulations
properly. To represent a situation in which there is no suitable
habitat for lamprey (i.e., Habitat Area is 0), set Habitat Area to 1
and Egg Survival Rate (see the section on setting Biological
Parameters, pg. 4-29) to 0.

Comments

Any special comments (eg. source of the information used).

The actions available from the Physical Reach Parameters screen are:

Calc Area

Add

Delete

Bio Parms

Exit

This feature is a calculation aid that generates values for the T.
Area and Habitat Area fields using the formulae shown in the field
descriptions for each (above).

Add a reach definition (either a copy of the current reach or with a
set of default parameters). This command adds the physical,
biological and age parameters for the new reach.

Delete the current reach. This command removes the physical,
biological and age parameters for the current reach. It also
removes reach references from the stream configurations (of which
the reach may be part), spawner allocation factors to the reach,
traps defined on the reach, references to locations of any barriers
located on the reach (barriers definitions are not deleted), and effect
of chemical options on the reach (chemical options are not deleted).

Reach biological parameters (see Biological Parameters section,
pg. 4-29).

Exits this screen.

The Stream Barriers screen allows addition (Add Barr button), removal
(Del Barr button) and modification of barriers to be simulated. This screen
can be accessed from the Stream Setup or Budget and Resources screens.
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Stream Barriers

Loke: [Sopoior |8

Stieam:[[10705] AMNICON RIVER

Bawmiers:
[BauiD |D ipti
I711.0W HEAD (JUMP POOLATRAP) -OLD WEIR SITE

" tart Y' Year;
$55,400.00 2463 2463

Planning:

c i [s277.20000 | [2484 ] [2484 ]
ortenoce wt St [T
Barier ion;

Str. Config. Bamier Location
[415] Single reach stream Not Present

[445] Stream with barrier [3] ABOVE NEW BAR.-OLD

The Lake and Stream fields display the names of the selected lake and
stream respectively. The Barriers field lists all of the barriers, both the
alternate and the concurrent, defined for a given stream. The BarrID
column uniquely identifies the barrier and the Description column provides
a short description of the barrier.

Barriers are brought "on-line" in three stages: planning, construction, and
operation. The planning and construction phases are described on the
Stream Barriers screen. The operation phase is described on the Stream
Barrier Activity and Budget and Resources screens. Both planning and
construction are described in terms of Cost from Start Year to End Year.
The cost is evenly distributed over the length of each phase.

The operating cost of a barrier is calculated according to its size, which is
expressed as a proportion of the size of a standard ($250,000) barrier in the
Maintenance wrt Standard field (wrt = with respect to). This proportional
value is currently calculated by: '

Planning Cost + Construction Cost
$250.000

Maintenance cost is calculated yearly by multiplying the average annual
operating cost of a standard-sized barrier (entered by the user in the Budget
and Resources screen) by the proportional value in the Maintenance wrt
Standard field. Additional non-recurring costs can be specified on the
Extraneous Stream Barrier Costs screen (see Ext. Expenses, below). The
years of operation (and thus start of maintenance) are defined on the Stream

Barrier Activity screen.

ESSA Technologies Ltd.
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Stream Barrier
Activity

A barrier may be present in one or more stream configurations. As well,
multiple barriers may be present within a single stream configuration.

The Barrier Location field lists the configurations that have been defined
for the current stream (Str. Config column) and describes the location of

barriers on each (Barrier Location column). If the currently selected barrier

is not present in the currently selected stream configuration, the Barrier

Location should be set to “not present”.

Clicking on the Ext. Expenses button opens the Extraneous Stream Barrier
Cost screen. This screen lists all of the non-recurring costs related to the
operation of a barrier. Different sets of extraneous expenses are listed for
each stream configuration where a barrier is present.

Extraneous Stream Barrier Cost
Lake: Superior Stream: [10705] AMNICON RIVER

Extraneous Expentes (list ok
Year |A t D ipti

Expenses are described by the fields:

Year The year of the expense.
Amount The dollar amount.
Description A short description.

Expenses can be added and removed by pressing Add and Remove
command buttons respectively. You can modify the values by simply
overtyping existing values. The Exit button exits the screen.

p> Other extraneous expenses can be specified on the Budget and
Resources screen.

Press the Activity button on the Stream Setup screen to reach the Stream
Barrier Activity screen. You can also access this screen by pressing
Barriers from the Budget and Resources screen.

4-23 ESSA Technologies Ltd.



LCSS User Interface

LCSS: User Guide

Stream Barrier Activity

Btream with barries

Barrier (BanEfHYP

‘baiier active 10

O Default for the stream configuration (Reach Set)

Active Bariers:

Stream barrier activities define what happens in the stream over the course
of the simulation. They affect the allocation of spawners within a stream.
Information displayed relates only to the currently simulated stream
configuration.

By default, the Lake, Stream and Stream Configuration selected on the
Stream Setup screen are displayed. If you wish to examine a different lake
or stream, make your selection using the drop-down lists at the top of the
screen.

To select a stream with a specific barrier, press the Pick Barrier button.
This brings up a list of all of the barriers that have been defined for use in
the simulation, as shown below.

All Barriers Potentially in Simulation

{0 242 SALMON R.] Modified mill dam

{0 10058 LITTLE SALMON R_] Esisting Mill Dam

[S 10078 SULLIVANS CREEK ] LOW HEAD JUMP POOL&TRAP) -h 58

S 10611 BAD RIVER LOW HEAD {JUMP POOLETRAP] -MAIN @ ELMHO!
LOW HEAD [JUMP POULLTHAP] .OLD WEIR SIt

1S 10712 NEMADJI RIVER 1 LOW HEAD JUMP POOLETRAP) -BLACK - OLD

{€ 111 FORESTVILLE] fow head - jump pool - trap

{S 369 LITTLE GRAVEL] fow head - jump pool - trap

{0 92 CREDIT R.]low head - jump pooi - rap

[0 110 ROUGE R.] low head - jump pool - trap

[0 121 LYNDE CR.] low head - jump pool - trap

{0 10019 BLACK F.] low head - jump pool - trap

{0 10064 BIG BAY CR {0SWEGO]] low head - jump

To select a barrier, click on the name and press OK. This will return you
to the Stream Barrier Activity screen with your new stream selection in
place.

All of the stream barrier activities for the current stream configuration are
displayed in the Stream Barrier Activity (BarrEffHyp) table. In the example
above, two different barrier activities are listed: "no barrier or barrier not
active", and "barrier active". Each barrier activity has an associated default
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Sterile Male Release Rate (SM Rate) and Sterile Male Release Count (SM
Count) used for SMRT, and chemical options (ChemOpt).

To define a new stream barrier activity:

Note that at least one chemical option must exist before a stream barrier

activity can be defined.

1. Click on the Act Add button in the Stream Barrier Activity screen.

2. Highlight your new entry with the cursor and enter a description of the
stream barrier activity (e.g. "barrier active").

3. If this is the default activity for the stream, select the "Default for the
stream configuration" option.

4. If this is not the default activity for the stream, specify the year in
which this activity should take effect by pressing Yr Add. You need
only specify the year in which the activity changes. The barrier activity
remains the same until a new value is found or the simulation ends.

5. For each active barrier, check that the appropriate spawner allocation
and chemical treatment option have been defined for the activity by
examining the screens accessed by clicking on the Spawners and Chem
Opt buttons. (More information on these two screens is provided
below.)

To remove a stream barrier activity:

1. Select the stream barrier activity you wish to remove.

2. Press Act Remove. All associated spawner allocation information will
also be deleted by this action.

When you select a year in the year list, the stream barrier activity that is
associated with that year is highlighted. Likewise, if you select a stream
barrier activity, all of the years when that activity is turned on are
highlighted. A

For example, for the Amnicon River (as displayed in the Stream Barrier
Activity screen above), the default stream barrier activity is "no barrier or
barrier not active". This default activity is in effect from 1958 (the first
year of the simulation) until 1979. In 1980 the stream barrier activity
changes to "barrier active". The barrier remains active until 1989, when the
barrier activity changes again to "no barrier or barrier not active”.

Use this screen to enter the default SM Rate and SM Count values. SM
Count refers to the number of sterile males released in the stream, and SM
Rate is the ratio of sterile males to non-sterile males released. More details
about SMRT are found later in this section (page 4-41).
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Chemical Option
Details

Once you have defined the stream barrier activity, you should examine the
default chemical treatment options associated with the barrier and the
allocation of spawners to the reaches of the stream. This information can
be accessed by clicking on the Chem Opt and Spawners buttons on this
screen. Each is discussed below.

The Chemical Option Details screen is used to view and modify the
chemical treatment option for the currently selected lake and stream. This
screen can be accessed from the Stream Barrier Activity screen by selecting
the Chem Opt button. The default chemical option for the activity will be
selected. The Chemical Option Details screen can also be accessed from
the Trip Management screen by clicking on Modify. In this case, the
currently selected chemical option will be used. Finally, the Chemical
Option Details screen can be accessed when you select Chem Opt from the
Stream Info screen (double-click on any stream displayed in the Ranked
Stream List on the Treatment Scheduler to access Stream Info). Here, the
chemical option shown as selected will be the one the system uses in the
stream ranking process.

Chemical Option Details

Lake: Superioc Stream: [10705] AMNICON RIVER
“hemOpt | Description SysOpt  |In Clg.
|84 Yes Tue
35 default (no barrier) Yes True
539 |basier - no tieatment No True

™ Window T
Type: E Start: [152 | End: [304 l Crew Size:
05731796 10730796 | Treatment Length: E:

[ Chemical Information Mon Tasget Risk: E:

TFM: BayerGran:[g | Non Tatget C ]
on Target Cost:

TFM bars: BayerWP: [g | Mitigation Risk: [ ]

Probability of treatment failure: [::] Mitigation Cost: [::]

Each of the major fields on this screen is described below:

Lake Identifies the current iake.
Stream identifies the current stream.
ChemOpt A unique identifier that references the chemical treatment option.

Description  Provides a brief description.

SysOpt Choose “Yes" if you wish to identify the associated chemical option
as a “system option” that will be protected from accidental
modification.

ESSA Technologies Ltd. 4-26



LCSS: User Guide

LCSS User interface

In Cfg. Indicates if the chemical option is relevant to the current stream
configuration (true or false). This value is used to select possible
chemical option alternatives when picking the best one to use for
the stream.

Window Each treatment option is assigned a window type. A window is a
time period during which the treatment application occurs. Window
types are indicated as "P", preferred; "A", acceptable; or "N", not
acceptable. The Window Type will be used by the automatic
scheduler to select the treatment windows for each stream.

Start Date The start and end dates for the window types are entered as Julian
dates. The system automatically displays the standard month and
day format below this field.

Crew Size The crew size usually associated with this chemical treatment
option.

Treatment Length The number of days required by the selected crew to complete
the treatment.

Chemical Information These fields display the types and amounts of chemicals
used in the chemical treatment option, and the probability of
treatment failure.

NonTargetRisk A value from 0 to 1 of the treatment risk on non-target species.

NonTargetCost The probable cost incurred should the non-target species be
affected by the chemical treatment option.

MitigationRisk The likelihood of having to prevent or minimize any non-target
effects (0 to 1).

MitigationCost The cost of carrying out any necessary mitigation measures.
The actions available from the Chemical Option Details screen are:

Add Create a new chemical option. The system will allow you to use the
currently selected chemical option as a template for a new one.
The new option is entered at the bottom of the ChemOpt list. Modify
the values in each of the fields as necessary.

Delete To delete a selected chemical option.

Select Selects the current chemical option to be the new default option for
the Stream Barrier Activity screen or to be used as the current
treatment in the Trip Management screen. This button has no affect
on the Stream Info screen.

ReachEff Takes the user to the Treatment Effect on Reaches screen.

Exit Saves the current chemical option and exits the Chemical Option
Details screen.
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Treatment Effect  The Treatment Effect on Reaches screen is accessed by pressing the Reach
on Reaches  Eff button in the Chemical Options screen. It identifies the proportion of

ammocetes killed by the chemical treatment.

Treatment Effect on Reaches

Stream Reaches:

2 BELOW NEW BAR -0t ) WEIR SITE
3 ABOVE NEW BAR.-OLD WEIR SITE

The fields and buttons available from the Treatment Effect on Reaches
screen are:

Stream Reaches Lists all reaches in the current stream configuration.

Portion Treated Indicates the proportion of lamprey habitat affected by the
treatment.

Efficiencies by Age Treatment efficiencies for individual age classes. The usual
settings are .99 for high, .98 for medium and .95 for low efficiency.

Treat Specifies that the reach is to be treated.
Don’t Treat  Removes a reach from treatment by the current chemical option.

Set ChemEff Allows the user to enter a new chemical efficiency value for all age
classes. If you want to edit the chemical efficiency for a given age
class only, click on the ChemEff value that you want to edit and
enter the new value that reflects the portion of the age class killed.

Spawner  The Spawner Allocation to Reaches screen is accessed from the Stream

Allocation to  Barrier Activity screen by pressing the Spawners button. Use this option to

Reaches  gpecify what proportion of the spawners entering the stream should be
allocated to each reach within the stream configuration.

[ This screen allocates spawners from streams to reaches. To allocate
spawners from basins to streams, choose the Lamprey Allocation
option in the Edit Menu.
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Biological
Parameters

General/Basin
Parameters

Spawner Allocation to Reaches

Lake: [Guperior  |Stream: [ 10705] AMNICON RIVER 1
Stream Configurati [Stream with barrier ]

Barrier A ier active |

Total Habitat Area: 118601

As a general rule, the spawner allocation is set proportional to the habitat
area in each reach. This calculation can be done automatically by clicking
on the Proportion command button at the bottom of the screen. In some
cases, however, an operational barrier may block the passage of lamprey
upstream (see screen example above) and the values in the Allocation to
Reach column will be 1 (below the barrier) and O (above the barrier). The
sum of allocation values for all reaches within a stream configuration
should equal 1, otherwise the system will be inconsistent in its allocation
by allowing more (or fewer) spawners to spawn than arrived in the stream.

The combination of the spawner allocation and the trapping mortality
determines the number of spawners arriving in the reach. More details on
how these numbers are used can be found in the model description in
Appendix A.

Choosing Biological Parameters from the Edit Menu lets you modify the
lamprey model parameters. Three categories of parameters are available for
editing: General and Basin parameters, Reach parameters, and Age
parameters. This set of screens can also be accessed from Stream Setup by
clicking on the Configuration button (- Stream Configuration screen), the
Reach button (-~ Physical Reach Parameters screen) and the Bio Parms
button (= Biological Parameters screen). Parameters can be modified
simply by overtyping the old values with the new.

Details on how the parameters are used can be found in the model
description in Appendix A.

Each category of parameters is listed on a tab at the top of this screen. By
clicking on a tab, you access screens for each.

The General/Basin Parameters screen contains two types of parameters,
those global to the whole simulation and parameters constant for the
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lamprey basins. This screen is the first of three Biological Parameters
screens.

Biological Parameters

Whale lake bases - % Groat Lakes each 1 sub-bas
AR L. Basing HSub-basmdcﬁnodn!haSIaku
Supenot J - Supero with 3 sub basins

This screen is one of two places where the currently simulated basin
configuration can be selected (see Lamprey Allocation, pg. 4-31). The
configuration highlighted upon exit from this screen will be used for the
next simulation (see Lamprey Basins in Chapter 2 for details on lamprey
basins).

The Lamprey Basin Configuration list holds all of the available lamprey
basin configurations. The Lamprey Basin list contains all of the basins
defined for the currently selected configuration. Adding, deleting and
modifying configurations can be done using the Lamprey Allocation screen
(see pg. 4-31).

Make sure that the streams simulated are those affected by the lamprey
basin definition. For example, if you choose a lamprey basin definition
that contains only Lake Superior, you should simulate only Lake
Superior streams, and not streams from the other lakes.

I Note that the current lamprey basin definition is always displayed
on the status bar at the bottom of the LCSS application screen.

Reach  The Reach Parameters screen displays parameters which are constant for
Parameters  each reach. This screen is the second of three Biological Parameters
screens.
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[ You can simulate no suitable spawning habitat (remember that you
cannot set Habitat Area to 0, see pg. 4-21) by setting Egg Survival
Rate here on the Reach Parameters screen to 0.

Age Parameters  The Age Parameters screen contains parameters specific to each ammocete
age class. This is the third of the Biological Parameters screens.

> O
1
2
3
4
5
]
7
8
S
1

o

Lamprey The Lamprey Allocation set of screens, accessed via the Edit Menu,
Allocation  governs movement of transformers and spawners between lakes and
streams.

There are three sets of parameters accessible through the following tabs:
Basins, Static Allocation, and Dynamic Allocation.
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Basins

Configuration Name |Description

Superior with 4 sub-basins
Superior with 1 sub-basin
L. Ontario with 1 sub-basin
New Basin Configuration

Spn Iloc on:
@ static

[ Canada-Noith O Dynamic

The Exit button, located below the tabs, exits the Lamprey Allocation set
of screens.

The Basins screen is the first of three Lamprey Allocation screens. It
allows addition, removal, modification and selection of the lamprey basin
configurations (also see General/Basin Parameters section, pg. 4-29).
This screen also allows selection of the spawner allocation strategy to be
used in the next simulation (static vs. dynamic).

The lamprey basin configurations subdivide the lake lamprey population
into distinct groups (see also Lamprey Basins in Section 2 of this manual).
The lamprey basin configurations can be added and removed by pressing
the Add and Remove command buttons just below the list of configurations.
The name of the configuration and the configuration description can be
modified directly in the table. The configuration selected upon exit from
this screen will be used in the next simulation. The Lamprey Basin field,
located below with its own Add and Remove buttons, lists the basins which
define the selected configuration.

The spawner allocation strategy can be selected by clicking on one of the
two choices listed. Detailed descriptions of each are given below.

Press Exit if you want to exit Lamprey Allocation, or press one of the other
tabs at the top of the screen to edit values in the Static Allocation or
Dynamic Allocation screens.
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Static Allocation

Make sure that the streams simulated are those affected by the lamprey
basin definition. For example, if you choose a lamprey basin definition
that contains only Lake Superior, you should simulate only Lake
Superior streams, and not streams from the other lakes.

I>> Note that the current lamprey basin definition is always displayed
on the status bar at the bottom of the LCSS application screen.

The Static Allocation screen is the second of three Ldmprey Allocation
screens. It contains parameters that govern the static allocation of
transformers from streams to lamprey basins and from lamprey basins to
streams.

S 1 Canada 7.428192E-05

S 2 Canada 1.400199€E-03

S 4 Canada 1.95239€E-03

5 5 Canada 4.023107£-03

S 23 Canada 5.051171E-04

) 24 Canada 0781745

S 36 Canada 4 853086E-04

S 39 Canada 1.733245E-04

S 41 Canada 2.971277€-03

S 48 Canada 2.271872E-02

S 52 Canada 0283984

S 54 Canada 5.581074€-03

S 56 Canada 5.699402€-03

S 93 Canada 3.014196E-03

S 100 Canada 1.168702£-03

S 116 Canada 4.930278E-04

s |167 Canada 1448516 o
S 202 Canada 9.343015E-04

S 301 Canada 5.807868E-02 g

Static lamprey allocation is one of 2 strategies available for simulating
movement of lamprey between the basins and streams (see also Dynamic
Allocation, pg. 4-36). In static allocation, the proportions of lamprey
allocated from streams to basin and basin to streams are fixed and are
independent of changes in the streams (e.g., ammocete densities).

The Allocation field in the Basin-to-Stream Allocation table contains the
proportion of all spawners in the stream's basin that are allocated to the
stream from the basin. Multiple basins can contribute spawners to one
stream. The total of all proportions for a particular basin should always add
to 1 (see Normalize, below).
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Synchronize
Allocation

Normalize

The Switch button switches the screen between basin-to-stream allocation
and stream-to-basin allocation. In the Stream-to-Basin table, the Allocation
field contains the proportion of a stream's transformers migrating to a |
particular basin. Streams can contribute transformers to multiple basins and
the total allocation for any stream should add up to 1.

The allocation proportions can be modified either manually by overtyping
the values in the table or according to an allocation rule (see Static
Allocation Rule below).

Command buttons Add and Remove allow adding and removing streams
from the allocation list. Multiple entries in the stream-to-basin list allow
splitting of the contribution from a stream among multiple basins. Multiple
entries in the basin-to-stream list allow multiple basins to contribute
spawners to a single stream. ’

US> The lamprey basins displayed in the allocation tables belong to the
lamprey basin configuration selected on the Basins tab.

The Synchronize Allocation screen automates the synchronization of
selections of streams to be simulated with the stream-basin-stream
allocations. It can be accessed by pressing the Synchronize button in the
Static Allocation screen.

=] -, Synchronize Allocation

Basin Configuration: Superior-3

@® Set simulated selection to allocated
Set to true all of the “simulate™ and "treat”
flags (Stream Setup screen] for streams
with allocation.

O Set allocated selection to simulated
Allocate spawners to and transformers from
all of the streams with the “simulate™ flag
set to true {using the allocation rule].

The Synchronize Allocation screen has 2 choices. The first modifies the list
of simulated streams to match those with allocation, the second modifies the
allocation list to match the simulated streams.

The Synchronize button in this screen initiates the synchronization process.

The Normalize function scans all of the Allocation values and ensures that
all values for any given stream add up to 1 (100%). If you have changed
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any of the values, they are preserved and the remaining values are scaled
based on their relative magnitudes.

For example, in a hypothetical basin there may be three streams: A, B, and
C. Suppose the original allocation was Stream A: 0.2; Stream B: 0.3; and
Stream C: 0.5. If the allocation to Stream A is altered to 0.3, and you
select Normalize, the allocation to Streams B and C would change to
0.2625 and 0.4375 respectively, thus adding to 1.0. The allocations to
streams are scaled in a way that would preserve the original ratio.

In some instances, it may be impossible to normalize the allocation. This
would occur, for example, if all of the values for a particular basin in a
basin-to-stream allocation were user-entered. In this case, an error message
is displayed when you try to normalize the allocation.

The normalization routine is automatically invoked when you Exit the
Lamprey Allocation set of screens.

To allocate spawners from a basin to a stream.

1. Go to the Static Allocation screen. Ensure that the description at the
top of this screen reads Basin-to-Stream Allocation. If it doesn't, press
the Switch button.

2. Select the stream for which you wish to edit the lamprey allocation. (If
you need to verify the stream name or number, go to the Stream Setup
screen.)

3. Enter a new value (from O to 1) in the Allocation field. Repeat steps 3
and 4 for all of the streams you wish to modify.

4. Press Normalize to redistribute lamprey allocation evenly across all of

the streams.

To allocate transformers from a stream to a basin:

1. Go to the Static Allocation screen. Ensure that the description at the
top of this screen reads Stream-to-Basin Allocation. If it doesn't, press
the Switch button.

2. Select the stream for which you wish to edit the lamprey allocation.

3. Edit the values in the Allocation field to change the current allocation
of transformers from the stream to the basin. For most streams, 100%
of lamprey will be allocated to a specific basin. However, for some
streams located near the junctions of two or more basins, a stream
could contribute transformers to multiple basins. In these cases, enter
a value that indicates the proportion of lamprey that should be allocated
to the basin.

4. Press Normalize to re-normalize the transformer allocation.
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Static Allocation
Rule

Dynamic
Allocation

The Static Allocation Rule screen allows entry and modification of the
allocation rule used to generate the static basin-to-stream allocation. The
screen can be accessed from the Static Allocation tab on the Lamprey
Allocation screen.

Static Allocation Rule
Stream Class: Allocation:

X .9
[3] Treated once ina whlle 095

.005

Totok: 1

The static allocation rule is centered around stream classes (see the Stream
Configuration section, pg. 4-19). These classes represent the "attraction"
of lamprey to streams. The Stream Class list contains all of the classes
present in the simulation. The static allocation rule allows the grouping of
one or more classes and the Allocation of proportions (Total = 1) of basin
spawners to these groups. The Add and Remove buttons add and remove
Allocation values. Selecting stream classes adds them to the current group.

The Generate button erases the current basin-to-stream allocation and
generates a new one based on the stream-to-basin values. The allocation
within the stream class groups is proportioned according to the spring
discharge of the stream. The same rule is used to calculate the basin-to-
stream allocations for all of the basins in the current lamprey basin
configuration. When there is more than one basin simulated it is possible
to have basins which contain only a subset of all stream classes and a subset
of stream class groups. When this situation is encountered the algorithm
splits the missing group's allocation in proportion to the values of
remaining stream class groups. For example if basin 1 contains streams
with classes {1, 2, 3}, basin 2 contains classes {1, 2, 3, 4} and the stream
class groups are: A = {1, 2}, B = {3}, C = {4} then for basin 1 the
algorithm splits the allocation for group C between groups A and B. When
a stream is contributing transformers to multiple basins the flow is
"apportioned" to the basins based on the stream-to-basin allocation and the
stream receives spawners from each basin based on the portion assigned to
the basin.

The Dynamic Allocation screen is the third of the three Lamprey Allocation
screen. It allows the definition of the dynamic allocation rule.
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Traps

Lamprey Allocation

Dynamic allocation is the second of 2 alternative strategies for allocating
spawners returning from basins to streams (see Static Allocation, pg. 4-33
above). It incorporates dynamic criteria (e.g., ammocete count) into the
allocation in addition to static criteria. This approach allows exploration
of criteria for "attractiveness" of a stream to lamprey.

Currently there are 3 criteria supported:

Discharge - stream spring discharge (a static criterion)

Ammocete Count - total number of ammocetes within a stream
Ammocete Count/Discharge - simulates "pheromone” concentration

The dynamic rule can be any linear combination of these criteria. The rule
is applied in a fashion similar to the static rule. The static stream-to-basin
allocation is used to determine which streams will receive spawners from
which basins, then the allocation factors are computed based on the value
of the combined dynamic allocation criteria.

You can simulate the placement of traps in reaches by using the Traps
option. This option is available by selecting Traps from the Edit Menu, or
by pressing the Traps button on the Budget and Resources screen.

=] Default Trap Placement

Lake: | Superior :} [XT®RE 110705) AMNICON RIVER ' § 1

Stoam Configuation:  [Stream with barier
Stroam Bacries Activity:  [no bariet of barier not acitve

T e < = SR
tost ttap 2 $2.000.06  |Hot on barter.
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Default Trap
Placement

This screen allows you to define the placement, efficiency, and cost of
default traps. (To add, modify or remove non-default traps, see the section
on Non-default Trap Placement, below.)

IS A default trap placement is specific to the stream barrier activity
being simulated on the stream to which the trap is added. In the
example above, the stream barrier activity for the Amnicon River
is set to “no barrier or barrier not active”. The trap is present (on
Reach 2) whenever this stream barrier activity is simulated.

Fields and buttons on the Default Trap Placement screen include:

Lake/Stream Click on the drop-down list to choose the lake and stream on which

you wish to place the trap.

Stream Configuration Currently simulated stream configuration.

Stream Barrier Activity One of the stream barrier activities created for the current

Reach
Description

TrapEff

AnnOpCost

Barrier

Overview

Non-default

Copy

Add
Remove

Exit

stream configuration.

Click on the drop-down list to place the trap on a particular reach.
Enter a description of the trap.

Enter a value between 0 and 1 to represent the efficiency of the
trap. A value of 0.2, for example, specifies that 20% of all lamprey
swimming by this trap (to the reach on which the trap is located and
all the reaches above it) are caught.

Enter the annual cost to operate the trap.

A barrier (if there is one) with which the trap is associated. By
clicking on the arrow button, you can choose from a drop-down list
of barriers present on the stream.

Activates a summary screen which shows the cumulative effect of
the default and non-default traps (see Summary of Trap Activity

below for more detail about Overview).

Switches the user to the Non-default Trap Placement screen (see
below).

Uses one of the “template” traps to create the new trap.
Inserts a “blank” entry.
Removes the currently selected trap.

Saves your changes and exits this screen.
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Non-default Trap
Placement

To place traps at specific times, click on the Non-default button in the
Default Trap Placement screen. This action activates the Non-default Trap
Placement screen. Whereas default traps are linked to stream barrier
activity, non-default traps are defined for a given year and are not
dependent upon the stream barrier activity being simulated.

Non-default Trap Placement

Lake: Stream:
E 93] AGAWA
H 10705] AMNICON RIVER
M {10018] ANKODOSH CREEK
0 [10104] ANNA RIVER
[10901] ARROWHEAD RIVER

[10110] AU TRAIN RIVER

[10611] BAD RIVER

[52] BATCHAWANA

[10090] BEAVER LAKE CREEK
[10027] BETSY RIVER

Sort Order: @ Name O Number
Non-default Trap Placement:

Fields and buttons on the Non-default Trap Placement screen are:

Lake/Stream Select the lake and stream on which you wish to place the trap.

Sort Order You can choose to sort lake and stream lists by name or by
number.

YearTrapOn  First year the trap is active.

YearTrapOff First year the trap becomes inactive.

TrapEff Proportion of lamprey the trap catches in the reach where it is
placed and all the reaches above it.

AnnOpCost  Annual operating cost for the trap.

Add Adds an entry to the Non-default Trap Placement table.

Remove Removes the currently selected entry from the Non-default Trap
Placement table.

Exit Exits the screen.
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Summary of Trap
Activity

Non-default trap placements act in addition to traps placed in the stream by
default. However, when a stream barrier activity changes (and with it the
default trap placements), all of the non-default placements are reset (see
Summary of Trap Activity below for an example).

The Summary of Trap Activity screen is accessed by selecting the Overview
button on the Default Trap Placement screen. This screen allows you to
view summary information about the cumulative effects of default and non-
default trap placements on the reaches of a particular stream.

o Summary of Trap Activity L v fia]

e
i[16705] AMNICON RIVER 3
__SimYear [Lake Stream 2 3
19561S 10705 2 2
1973)8 10705 % 38
1975(5 10705 2 2
1977|s 10705 2 A4
1980|S 10705 19 19
1363|s 10705 595 595
19845 10705 .55 .55
1980|s 10705 2 2

The fields on this screen show the simulation year, the lake, the stream
number, and the reaches of the stream. In the example above you can see
that Amnicon River has two reaches, numbered "2" and "3". Note, that if
multiple streams are displayed, all of the reach numbers are shown. Some
of these may not be relevant for some of the streams.

The summary table displays the net effect of the various traps.

From 1956 until 1971 the default stream barrier activity is "no barrier or
barrier not active", so the trap efficiency is 0.2 (to double-check these
values, look at the Default Trap Placement, Non-default Trap Placement,
and Stream Setup screens). In 1972, a trap is placed on reach 2 with a trap
efficiency of 0.2. The net effect of both traps is a trap efficiency of 0.36
(64% of the lamprey are not caught). This trap efficiency remains in effect
until 1975, when the trap is removed. Note that the trap efficiency affects
both reaches equally.

In 1977, another trap is placed on reach 3 (which is located above reach 2).
Its trap efficiency is 0.3, so the net effect of the traps is 0.44 (56% of the
lamprey are not caught) on reach 3. In 1980, the stream barrier activity
changes from "no barrier or barrier not active" to "barrier active”. The
default trap placement for this barrier activity is a trap with an efficiency
of 0.1. However, a trap was also placed on reach 2 in 1980, so the trap
efficiency for both reaches for this period is 0.19. In 1983, a second trap
is placed on the stream with an efficiency of 0.5; the cumulative effect of
all three barriers is 0.595. Finally, in 1990, the stream barrier activity
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SMRT

changes back to the default activity which is "no barrier or barrier not
active". The trap associated with this barrier activity has an efficiency of

0.2.

The Sterile Male Release Technique screen is accessed when you choose
SMRT from the Edit Menu. This option is used to set the non-default
release of sterile males to any stream present in the database.

Sterile Male Release Technique

Hon-default Sterile Male Releases:

Sort Order:
@ Name O Number

SMCount SMReiRt
2
3

Fields and buttons on the Sterile Male Release Technique screen are:

Lake/Stream Select the lake and stream into which you wish to release sterile

Sort Order

SimYear
SMCount

SMRelRt

Overview

Default

Add
Remove

Exit

male lamprey.

You can choose to sort lake and stream lists by name or by
number.

The year of sterile male release.

The actual number of sterile males released.

The ratio of sterile to non-sterile males. For the Amnicon Rivef, as
shown above, the SMRelRt in 1995 is 2, which means that 2 sterile
males are released for every 1 non-sterile male.

Not implemented. Shows the summary of the SMRT program.
Activates the Stream Barrier Activity screen where you can enter
the default sterile male release counts or ratios for any of the
stream barrier activities for the current stream configuration. Exit
returns you to the SMRT screen.

Adds release entries for the currently selected stream.

Removes release entries for the currently selected stream.

Exits the SMRT screen.
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Basin
Population

0> The entered sterile male values will only apply to the currently
selected stream configuration. If at a later time you select a
different stream configuration, the values will change to the default
values associated with the new stream configuration and you will
have to enter a new non-default release schedule. If, in a later
simulation, you select the old stream configuration, the schedule
you chose earlier will apply once more.

The Basin Population screen is used to view/enter population values (eg.
number of transformers) for each of the lamprey basins in the currently
selected basin definition. To make changes, simply click on the field to be
modified and type in the new values.

Basin Population

Current basin definition: Superior-3

Sub-basin in the cumrent basin defn: [T ]

Values entered in this screen constitute initial population conditions for a
particular year and will be used by LCSS to run the simulation for the next
consecutive year. For example, if you enter initial stream population data
for 1987, these will form the basis for a simulation run of 1988 conditions.

At the top of this screen is the Current basin definition field. This field
identifies the currently selected basin definition. To select a different basin
definition, go to the Lamprey Allocation set of screens in LCSS (see
Basins, pg. 4-32). Below this, the Sub-basin in the current basin defn field
allows users to select the specific sub-basin for which they wish to
view/enter population data using the accompanying drop-down list.

Other fields in this screen are:

Year This field identifies the year to which the data apply and it cannot be
modified.
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Stream
Population

Transformers
Count The number of transformers in the basin.
PropFem  The proportion of the total transformer count that is female.

Parasitic Phase
Count The number of parasitic phase lamprey in the basin.
PropFem  The proportion of the total parasitic phase count that is female.

Spawners
Count The number of spawners in the basin.
PropFem  The proportion of the total spawner count that is female.

To enter data for a new year, click Add Year. You will be prompted to
enter a specific year, then click OK (or Cancel to abandon the request). A
default set of population values for the new year will be automatically
entered into the Basin Population table. Modify these data as appropriate
by clicking on each field and typing in the new values. To delete a row of
data, select it with the mouse and click Del Year.

To return to the Main Menu, click Exit.

The Stream Population screen is used to view/enter ammocete population
values (eg. ammocete density) in the currently selected stream. Data are
organized by year, specific reach and lamprey age (these three fields cannot
be modified) and users can modify/enter data in the remaining four fields
by simply clicking on the field to be modified and typing in the new value.

Stream Population

ok wd h ok ok owh b b
WO~ mWN i

Values entered in this screen constitute initial population conditions for a
particular year and will be used by LCSS to run the simulation for the next
consecutive year. For example, if you enter initial stream population data
for 1987, these will form the basis for a simulation run of 1988 conditions.
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Choose the Lake and Stream from the drop-down lists at the top of the
screen. The fields in the table are:

Year This field identifies the year to which the data apply. This field
cannot be modified.

Reach This field shows the number of the reach. This field cannot be
modified.

Age Lamprey age (from 0 to 10 years) appears in this field. This field

cannot be modified.

AmmSurv Ammocete survival is expressed as the proportion of each age
class surviving the year. AmmSurv is a calculated value dependent
upon the total ammocete density and the shape of the SLP curve
(see Biological Parameters, Age tab in LCSS, pg. 4-29).

AmmbDen Ammocete density is expressed in number of individuals per square
metre (#/m?).

AmmLen Ammocete length is expressed in millimetres (mm).

TransYear This field describes the stage of transformation for lamprey in each
age class (see section Simulating Transformation to the
Parasitic Phase in Appendix A).

The two command buttons on the Stream Population screen are Add Year
and Del Year.

Add Year activates the New Population Records screen. The Lake and
Stream fields identify the currently selected lake and stream. Choose the
year and specific reach you wish to add to the Stream Population table and
click OK. Modify the values for ammocete survival, density, length and
transformation year by overtyping the current values with new ones.
Repeat this process for each reach you wish to add.

New Population Records

Lake: Superior

Stream: [10705] AMNICON RIVER

Reach: [[1] ENTIRE SYSTEM

Yo

To delete population records for a specific year and reach, use the mouse
to select any row of data in the year and reach you wish to delete. Click
on the Del Year command button.
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LongTerm
Menu

Lamprey Control Selection System

6 Delete all records for year 1957 and reach 17

Repeat this process for every reach you wish to remove for the specified
year.

[ When a new reach is created using the Stream Setup family of
screens (see pg. 4-17 in LCSS), the system adds it to the list of
reaches in the Stream Populations screen. Population information
can be entered/modified as appropriate. Note, however, that the
reverse is not true. The Del Year function in the Stream
Populations screen deletes only the lamprey population information
associated with the selected reach and not the physical reach itself.
To delete a reach altogether, you must use the Physical Reach
Parameters (pg. 4-20) screen in Stream Setup.

Exit returns the user to the Main Menu.

Long-term runs help you evaluate the long-term performance of alternative
selection criteria and budget limitations.

Long Term Runs

Stast Year: |1994
End Year: |1934

" Run Type
O Resource limited

@ Scheduled Treatments
QO Automatic Schedule

Chem. Opt. re-evaluation
O All Steams

O Barier Streams Only

@ No re-evaluation

[ Spawner Allocation:
@ Static
O Dygnamic

] Compact Database before run

To carry out a long-term run:

1. Enter the start and end year dates (the calculation horizon).

2. Choose the desired run type (see below for descriptions).

3. Select the optional database compacting command. Compacting can be
disabled if a run is extended for a few years.

4. Indicate which chemical option re-evaluation you wish to use.

Select a spawner allocation strategy.

9,1
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6. Press Run.

There are three run types: resource limited, scheduled treatments and
automatic schedule.

Resource Limited Erases the existing schedule, and selects streams for
treatment in priority (as determined by the ranking criteria), using
the availability of chemicals, time, and money as the only
limitations.

ScheduledTreatments Applies the current schedule for the range of years shown.
This is done on a year-by-year basis when moving forward through
the schedule. This option. can be used for applying historical
treatments.

Automatic Schedule Not implemented. Erases the current schedule and uses
the built-in expert system to build a treatment schedule. This option
adds logistic constraints to the suite of limitations examined in the
Resource Limited runs. This option is the same as pressing the
GenAll button in the scheduler.

During a run, a Stop Run button will appear. Pressing this button allows
you to interrupt a long-term run before the beginning of the next simulation
year. When the button is pressed, the system finishes the current year's
calculations and then stops. The Start Year field is automatically updated
to one year after the last simulated year. To continue the run, you need
only press the Run button again.

Clicking on the Resources button activates the Long Term Runs Resource
Limitations screen. This screen allows the user to specify how much of
each resource (e.g., money, person-days, chemical) is to be used in the
simulation run.

Leng Term Runs Resource Limitations

Select proportions of each of the resources to be uged in the current simulation.
FY: 1994
Money: [N _][.6osos06 | 773649.9
Person-days: — [a675325 | 301.4838
v |[-4372234 |0
1rm sars: [ 1[-4372294 |o
Bayer Granulor NN |0
Bager Wet Pwdr:— ][.5670996 Bl

Limiting the resources allows simulation of reduction of overall resources
(e.g., budget) for all of the Great Lakes or it can be used in runs where
only a part of the Great Lakes system is simulated (e.g., only Lake
Superior).
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Options Menu

The screen shows a list of all resources used in the simulation. A shaded
proportion of the bar next to the resource name represents the proportion
of the resource available. A numerical value of the proportion follows the
bar. On the right is the amount of the resource available for simulation for
the first year of the simulation. The limitations specified apply to all of the
years of simulation. To limit the availability of resources you can either
click on the bar or enter the proportion directly.

The Exit button exits the Long Term Runs Resource Limitations screen.

Results of the run can be viewed in Microsoft Access, by choosing
Database from the menu bar.

You can access the Microsoft Access database by choosing Database from
the Main Menu. You will be able to enter data and generate results from
the database.

= See Appendix C for an overview of the database interface.

Options which affect the system as a whole are accessed in the Options
Menu.

LCSS Options

[ Scheduling
Travel threshold {Maxi time bet

events for the same trip) [dF ]
Minimum Break Length [Minimum time [D

between events for overtime reset] [d]

" Budget Calculations
RAecalculate the budget every time it is
entered: (]

Check the previous year's surplus/debt
and chemical stocks on every recalc. : i

[ Simulation

Base Year: 1958
Highest Age Class (max 10} 10

Write Simulation Details to the databaze: [}
Recalculate the ranking list each year:

Each option is described below:

Travel threshold The maximum time between events for the same trip is used in
the scheduler to determine if a treatment or user event is a
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Help Menu

candidate for inclusion in a trip. If an event is dropped within the
threshold of another event, the scheduler gives users the option of
combining two events into a single trip, thus representing a single
trip time to and from the site.

Min. Break Length The minimum break length between treatments is used for
overtime calculations. If this amount of time is not spent, the two
events are considered "adjacent" and their time is combined for
overtime calculations. If the length of such combinations exceeds
10 days, any excess time is considered as overtime.

Recalculate budget When this option is selected, the budget is automatically
recalculated whenever the budget screen is entered.

Check surplus/debt This option provides continuity between years in terms of
money and stock levels. Enabling this option may not be
appropriate when such data are missing or incomplete.

Base year This is the base year used in the Budget, Treatment Scheduler,
Quick Schedule options and Long-Term Runs. The value changes
here whenever it is changed in the Long Term Runs screen and
vice versa.

Highest Age Class Set the age of the oldest lamprey to be used in the simulation
(the maximum allowable is age class 10).

Write Simulation Details to the database When this option is enabled, the
system will copy the details of the current simulation (eg. lamprey
numbers, density, length, allocation to reaches, etc. for 1958) into
the database. If you wish to run simulations for any years following
the year you are currently running (eg. 1958), you must select this
option. If you plan to run the same year repeatedly to test the
effects of various parameter values, leave this option disabled so
the run will proceed more rapidly.

Recalculate the ranking list each year |f you select this option, the system will
re-assess the order in which the streams will appear in the Ranked
Stream List (see Ranked Stream List field description, pg. 4-12).
As for the previous option, enabling this option will slow the speed
of the run somewhat.

Help is available in two ways: through the main menu and from each
screen. The help provided through the main menu is indexed for easy
reference and can be best used for getting an overall view of the system and
for finding out about specifics of the program's operation.

The help available from the screens is context sensitive and is related
directly to the options available from the screen. This type of help can be
invoked using the <F1> key while using the system.

ESSA Technologies Ltd.
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The information presented through both options is identical. The index
presents a top-down view of the system, beginning with general topics and
moving to more detailed information about LCSS. The context-sensitive
help goes directly to the section of the Help Menu most applicable to the
current screen.

The help files follow the standard Microsoft Windows Help format.
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5.0 ISIS User Interface

IMSL Stream Inspection System (ISIS) is a component of the IMSL suite
of decision support tools. The central theme for ISIS is the stream. ISIS
was designed to easily access and modify stream parameters and examine
the effect of these modification on the results of simulations.

This facility, however, would not be very useful without close ties with
LCSS (Lamprey Control Selection System). ISIS and LCSS share the
simulation model, including the stream treatments sub-model. ISIS is also
able to import and export stream parameters to and from any LCSS
scenario database. This allows ISIS to become a test bed for parameter
values. ISIS keeps its own copy of the parameters to allow LCSS to be
used independently without fear that the parameters in LCSS will change
unexpectedly.

Additionally, ISIS allows comparison of the results of stream simulations
to the collected assessment data for individual years or over a period of
time. This allows refinement of stream parameters which then can be used
in LCSS.

ISIS has four major components:

1) Data maintenance and 1/0 allows users to import data from LCSS,
create streams, delete sets of parameters or delete results no longer
needed. These options are located in the File Menu;

2)  The Stream construction component allows modification of a selected
stream. All stream parameters are available for review/modification
in the Edit Menu;

3)  Model utilizes the values of stream parameters stored in the database
to run the lamprey model (see Model Menu section, p. 5-20); and

4)  Results review allows comparison of results of model runs using
single or multiple streams to each other and to the assessment data
using tables and graphs (also Model Menu).

Note: ISIS is still in a prototype stage and not all of its functions are fully
implemented. This document describes the program'’s current or intended
function.

The Main Menu gives you access to all parts of the system. Menus and
submenus are described below in separate sections. In addition to the main
menu, there is a button bar located just below the menu which provides fast
access to the most frequently used functions of ISIS.
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IMSL Stream Inspection System

File Menu

The functions provided through the button bar are (in order):

from the File Menu:

New Stream Scenario
Select Stream Scenario
Delete Results Scenarios
LCSS Scenario DB Import
LCSS Scenario DB Export

from the Edit Menu:
U Stream Parameters

from the Model Menu:
° Run
U View Results

from the File Menu:
. Exit

A detailed description of the functions listed can be found under individual
menu sections.

The bottom of the screen identifies the currently selected stream. This
choice can be changed using menu items New Stream Scenario, Select
Stream Scenario or by selecting a stream in the Stream Parameters screen.

The File Menu contains the data maintenance and I/O functions. The
options most often used are also present on the button bar.

New Stream Scenario creates a new stream Stream Scenario

either with default parameter values or with a Select Stream Scenario

copy of parameters from another stream. LCSS Scenario DB Import
LCSS Scenario DB Export

Select Stream Scenario opens an existing Delete Stream

stream for manipulation. This same function Delete Run Result

can also be performed by selecting a stream Exit
in Stream Parameters (see p. 5-4).
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LCSS Scenario DB Import and LCSS Scenario DB Export allow movement
of parameters between the ISIS database and the LCSS Scenario database.

Delete Stream allows the removal of stream parameters and run results for
a particular stream from the ISIS database.

Delete Run Results deletes individual run results for the current stream.

The Exit option ends the program execution.

ISIS provides a facility for importing data from the LCSS database. This
function is available under the LCSS Scenario DB Import menu option in
the File Menu and activates the Import Stream screen. This function can
also be accessed from the button bar using the &g icon.

Import Stream
LCSS Database name:

[C:MIMSLASHIST.MDB j
Lake: LCSS Stream not in 1S1S Database:

[93] BIG OTTER
[10037] CANADAWAY CREEK
[87] CATFISH

[10023] CATTABAUGUS CREEK
[101] CLEAR

[10153] CONNEAUT CREEK
[10136] CROOKED CREEK
[10021] DELAWARE CREEK
[78] EAST

Sort Streams By:

woxrx

@ Name O Number

The import function copies all of the stream-related parameters from the
specified LCSS Scenario and the associated Options databases to the ISIS
database. These include physical parameters (i.e., stream configuration,
reach and age), barriers, stream activity, spawner allocations, chemical
options, treatment schedule, SMRT and trap data, and stream-basin-stream
allocation data.

To avoid the possibility of conflicts, currently loaded stream-basin-stream
allocation data are deleted prior to loading a new set of values. This may
cause some streams to behave differently following the loading of an
unrelated stream (due to different survival rates of parasitic phase lamprey
and different proportions of returning spawners, see Spawners tab pg. 5-
19).
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LCSS Scenario
DB Export

Delete Stream

Edit Menu

Stream
Parameters

The LCSS Scenario DB Export function complements the import function
described above. It allows transfer of parameter values from the ISIS
database to LCSS database. The Export Stream screen can also be activated
from the button bar using the [B icon.

Use the Delete Stream screen to remove the parameters and run results for
selected streams from ISIS.

= Delete Stream
Lake: 1519 Streams:

10705] AMNICON RIVER

{10122} LAUGHING WHITEFISH

icz:m

Sort Streams By: @& Name C Number

The Edit Menu contains the stream parameters that characterize each
stream. The only option, Stream Parameters, invokes the Stream
Parameters dialog.

! Stream Parameters |

The Stream Parameters dialog provides access to all stream-related
parameters. These are grouped into 9 tabs placed along the top of the
dialog. Most of the tabs contain layouts similar to those used in LCSS (see
the LCSS User Interface section of this manual). This family of screens can
be activated from the button bar ( ). The nine tabs are:

Stream Contains the general stream information. A stream selected here
is later simulated in 1SIS. The current selection is reflected at the
bottom of the main screen.
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Config Contains parameters defining the physical structure of the stream.

BioParms Contains biological parameters. A tabbed dialogue further
subdivides the parameter set in this screen.

Barriers Contains all of the currently defined barriers on the stream and
facility for deleting or defining new barriers.

Activity Contains the definition of the way the stream acts in response to the
activation and/or failure of barriers. Here you can also access the
chemical options and the default SMRT release settings.

Traps Allows definition of default and non-default trap placements.

SMRT Allows definition of overrides for the default SMRT releases
(defined in the Acfivity tab).

Spawners Defines the annual allocation of spawners to the stream.

Treatments Lists and allows modification of all of the chemical treatments
selected for the current stream.

Each of these tabs is described in more detail below.

Stream  The Stream tab contains a screen that is very similar to the Stream Setup
screen in LCSS (see pg. 4-17). It contains general information about the
streams loaded in the ISIS database.

070 A l i
[10104] ANNA RIVER

The Lake and Stream lists allow selection of a stream to be simulated,
viewed or modified. The stream list contains only the streams loaded into
the ISIS database. As streams are added to or removed from the database,
the list will change accordingly. The Stream list can be sorted by either the
stream Name or Number. The stream selection made here is displayed on
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Stream
Configuration

the status bar at the bottom of the screen, and is the one that will be used
for simulation runs. It will also be the currently selected stream in all of
the tabs in the Stream Parameters family of screens.

The Currently Simulated Stream Configuration list displays all of the
currently defined physical representations of the selected stream. The one
currently highlighted is used in the simulation. For more detail on stream
configurations see the Stream Configuration section in LCSS (pg. 4-19).

The Stream tab also allows modification of the following characteristics of
streams:

Stream Code Alternate code used in other lamprey program documentation.

Simulate The value of this flag is set to “true” (the checkbox is marked), ie.,
the stream selected here will be simulated. This field cannot be
modified.

Treat Specifies if the stream will be considered for treatment. If this flag

is not set to “true” by marking the checkbox, the treatments
selected on the Treatments tab will be ignored.

1

Default Chem. Opt. Only The default value of this flag is “true”, meaning that the
streams will always be treated with the options selected on the
Treatments tab. This field cannot be modified.

Latitude, Longitude, State/Province, and Country Define the stream location.

Class Is used in calculations of static basin-to-stream lamprey allocations
(see Lamprey Allocation section in LCSS, pg. 4-31).

Budget Group Is currently unused and should always be setto 1.

The Config tab allows entry and modification of stream configurations for
the currently selected stream. This screen is very similar to the Stream
Configuration screen in LCSS (see pg. 4-19).

A stream configuration is a definition of the physical layout of the stream.
It is composed of "reaches", non-overlapping sections of the stream acting
as homogenous units. The reaches are connected by defining a downstream
reach. The lowest single reach in a group should be defined to flow into
itself. A combination of reaches, a stream configuration, represents the
whole of the stream. A single reach may belong to multiple stream
configurations. A stream can have multiple alternate stream configurations,
although only one can be used in the course of a single simulation.

All of the stream configurations for the selected stream are listed in the
Stream Configuration table of the Config tab.

FQQA Tarhnninniec | td
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Stream Parameters B

Stream with barner

DownSte
ENTIRE SYSTEM
BELOW NEW BAR.-OLD WEIR SITE
ABOVE NEW BAR.-OLD WEIR SITE

The ID column in the table automatically generates unique identifiers for
stream configurations. The Description column provides short descriptions
of each configuration. New stream configurations can be added using the
Add Conf command button. Existing stream configurations can be
removed using the Del Conf button.

The Reach table lists all of the reaches defined for the stream for all of the
stream’s configurations. Reaches may overlap, although if they do they
should not be included in the same stream configuration. The Reach
column uniquely identifies the reach within the stream, ReachName
provides a short description of the reach, the In column specifies if the
reach is included in the currently selected reach configuration (true = yes),
and the DownStr column specifies which of the other reaches within the
current stream configuration is downstream of the selected reach.

Reaches can be added in two ways. The Reach button opens a screen
where individual reaches can be added, removed, or modified (see below).
The Split Reach button opens a screen that divides the currently selected
reach into 2 or more sub-reaches and allows users to define the habitat area
covered by each new sub-reach (see also LCSS pg. 4-19).

Clicking on the Reach button in the Config tab screen opens the Physical
Reach Parameters screen. This screen is identical to the Physical Reach
Parameters screen in LCSS. It allows addition/deletion of reaches and
modification of physical reach parameters.
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Physical Reach Parameters

Lake: E:} Stream: [10705 Reach: 7} @ [ Lentic Reach
Reach Name |[BELOW NEW BAR_-OLD WEIR SITE ]
Discharge (m3l:] Discharge Std Dev @::::I
R T N r—

Reach Width [m]}

Prop. High Qual. Prop. Med Qual.
T. Area (m2) Habitat Area (m2)
Comment: ! J

The reaches for the current stream can be selected from a drop down list.
Parameters available for modification are:

Lentic Reach This field consists of a checkbox to indicate whether the current
reach is a lentic reach.

Reach Name A short description of the reach.

Discharge Mean annual flow (in cubic metres per second) at the lowest most
part of the reach.

Discharge Std Dev Standard deviation of the discharge within the year.

Max. Length  The total length (in kilometres) of the reach.

Avg. Length  The length of the reach (in kilometres) inhabited by lamprey.

Reach Width Width of the reach (in metres) at the lowest most part of the reach.

Prop. High Qual. Proportion of the potential habitat area of high quality.

Prop. Med Qual. Proportion of the potential habitat area of medium quality.

T. Area Total reach area (usually Reach Width * Avg. Length) (in square
metres). This value can also be generated by clicking on the Calc
Area command button (see below).

Habitat Area  High quality equivalent of the area (usually T. Area * (Prop. High
Qual + 0.2 * Prop. Med Qual.)) (in square metres). This value can

be generated by clicking on the Calc Area command button (see
below).

> It is important to ensure that the value set for Habitar Area is
greater than 0, otherwise the system will not perform its simulations
properly. To represent a situation in which there is no suitable
habitat for lamprey (i.e., Habitat Area is 0), set Habitat Area to 1
and Egg Survival Rate (using the BioParms tab, below) to 0.

ESSA Technologies Lid.
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Comments Any special comments (eg. source of the information used).
The actions available from the Physical Reach Parameters screen are:

Calc Area This feature is a calculation aid that generates values for the T.
Area and Habitat Area fields using the formulae shown in the field
descriptions for each (above).

Add Add a reach definition (either a copy of the current reach or with a
set of default parameters). This command adds the physical,
biological and age parameters for the new reach.

Delete Delete the current reach. This command removes the physical,
biological and age parameters for the current reach. It also
removes reach references from the stream configurations (of which
the reach may be part), spawner allocation factors to the reach,
traps defined on the reach, references to locations of any barriers
located on the reach (barriers definitions are not deleted), and effect
of chemical options on the reach (chemical options are not deleted).

Bio Parms Reach biological parameters (see Biological Parameters section
in LCSS, pg. 4-29).

Exit Exits this screen.

The BioParms tab lets you modify the lamprey model parameters. Three
categories of parameters are available for editing: General parameters,
Reach parameters, and Age/Size parameters.

Stream Parameters %
£ ! r bl g %

To create a new set of parameters, click on the New Parm Set command
button. This action inserts a new set of parameters in all fields ready for
modification by overtyping. Del Parm Set removes the set of biological
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parameters currently displayed on the screen. The parameters set chosen
here will be used in subsequent simulations of the currently selected stream.

Details on how the parameters are used can be found in the model
description in Appendix A.

The Barriers tab contains a screen that allows users to modify the physical
and economic details of lamprey barriers.

Stream Parameters

4

15} §ihgle reach stream Not Prezent
45] Stream with barrier {3] ABOVE NEW BAR.-OLD

The currently selected barrier and reach are listed at the top of the screen.
Barriers can be added to this list (Add Barr command button) or deleted
(Del Barr). The Ext. Expenses command button opens an Extraneous
Stream Barrier Cost screen which is identical to the one in LCSS (see pg.
4-23). :

%ﬁ Extraneous Stream Barrier Cost
Lake: Superios Stream: [10705] AMNICON RIVER

Stream Configusation: Extraneous Expenses (list all):
415] Single reach stream Y A schiplic
445] Stream with barsier

Expenses are reported in the fields Year, Amount and Description. Existing
values can be modified by clicking on a cell and simply overtyping the
current contents. Expense information can be added and deleted from the
table using the Add and Remove command buttons.

FSSA Technoloaies Ltd.
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Values describing the cost of barrier planning, construction and
maintenance are displayed in the centre of the Barriers tab. These values
can be modified by overtyping currently displayed values with new ones.
A choice of stream configurations and barrier locations appears at the
bottom of the screen in the Barrier Location field.

The Activity tab contains a screen very similar to the Stream Barrier
Activity screen in LCSS (see pg. 4-23). Stream barrier activities define
what happens in the stream over the course of the simulation. Most
notably, stream barrier activities affect the allocation of spawners within a
stream. Activities displayed in this tab apply only to the currently
simulated stream configuration. '

All of the stream barrier activities for the current stream configuration are
displayed in the Stream Barrier Activity (BarrEffHyp) table. In the example
above, two different barrier activities are listed: "no barrier or barrier not
active", and "barrier active". Each barrier activity has an associated default
Sterile Male Release Rate (SM Rate) and Sterile Male Release Count (SM
Count), and chemical options (ChemOpt).

To define a new stream barrier activity:

Note that at least one chemical option must exist before a stream barrier

activity can be defined.

1. Click on the Act Add button in the Stream Barrier Activity screen.

2. Highlight your new entry with the cursor and enter a description of the
stream barrier activity (e.g. "barrier active").

3. If this is the default activity for the stream, select the "Default for the
stream configuration" option.
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4. If this is not the default activity for the stream, specify the year in
which this activity should take effect by pressing Yr Add. You need
only specify the year in which the activity changes. The barrier activity
remains the same until a new value is found or the simulation ends.

5. For each active barrier, check that the appropriate spawner allocation
and chemical treatment option have been defined for the activity by
examining the screens accessed by clicking on the Spawners and Chem
Opt buttons (see below).

To remove a stream barrier activity:

1. Select the stream barrier activity you wish to remove.

2. Press Act Remove. All associated spawner allocation information will
also be deleted by this action.

When you select a year in the year list, the stream barrier activity that is
associated with that year is highlighted. Likewise, if you select a stream
barrier activity, all of the years when that activity is turned on are
highlighted. For a more detailed description of this screen, see pg. 4-23
in LCSS.

This screen can also be used to enter the default SM Rate and SM Count
values. SM Count refers to the number of sterile males released in the
stream, and SM Rate is the ratio of sterile males to non-sterile males
released (see the SMRT section in LCSS, pg. 4-41).

Once you have defined the stream barrier activity, you should examine the
default chemical treatment options associated with the barrier and the
allocation of spawners to the reaches of the stream. This information can
be accessed by clicking on the Chemn Opt and Spawners buttons on this
screen. Each is discussed below.

The Chem Opt command button activates a Chemical Option Details screen
that is identical to the one used in LCSS.

g Chemical Option Details
Lake: Superior Stream: [10705] AMNICON RIVER

"85 detault {no bartier) Yes
539 ;batier - no treatment No

[ Window Crew Size: §
Type: Staet: [y55 End:
06/01/00 70737706 | Treatment Length: [¢__]
" Chemical Information ek~
Hon Target Risk:
TFM. Bayer Gian: 17 on target 1
_ Non Target Cost
TFM bars E.:j Bayes WP [0 ] E:
Mitigation Risk: S
Probability of treatment failure: | I Mitigation Cost: [::]

(add | [ pelete | [Roachin | [ seoct | [ Em |

ESSA Technologies Lid.
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This screen allows users to view and modify the chemical treatment option
for the currently selected lake and stream.

Each of the major fields on this screen is described below:

Lake Identifies the current lake.
Stream ldentifies the current stream.
ChemOpt A unique identifier that references the chemical treatment option.

Description  Provides a brief description.

SysOpt Choose “Yes” if you wish to identify the associated chemical option
as a “system option” that will be protected from accidental
modification.

In Cfg. Indicates if the chemical option is relevant to the current stream

configuration (true or false). This value is used to select possible
chemical option alternatives when picking the best one to use for
the stream.

Window Each treatment option is assigned a window type. A window is a
time period during which the treatment application occurs. Window
types are indicated as "P", preferred; "A", acceptable; or "N", not
acceptable. The Window Type will be used by the automatic
scheduler to select the treatment windows for each stream.

Start Date The start and end dates for the window types are entered as Juiian
dates. The system automatically displays the standard month and
day format below this field.

Crew Size The crew size usually associated with this chemical treatment
option.

Treatment Length The number of days required by the selected crew to complete
the treatment.

Chemical Information These fields display the types and amounts of chemicals
used in the chemical treatment option, and the probability of
treatment failure.

NonTargetRisk A value from O to 1 of the treatment risk on non-target species.

NonTargetCost The probable cost incurred should the non-target species be
affected by the chemical treatment option.

MitigationRisk The likelihood of having to prevent or minimize any non-target
effects (0 to 1).

MitigationCost The cost of carrying out any necessary mitigation measures.
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The actions available from the Chemical Option Details screen are:

Add Create a new chemical option. The system will allow you to use the
currently selected chemical option as a template for a new one.
The new option is entered at the bottom of the ChemOpt list. Modify
the values in each of the fields as necessary.

Delete To delete a selected chemical option.

Select Selects the current chemical option to be the new defauit option for
the Stream Barrier Activity screen or to be used as the current
treatment on the Treatments tab. This button has no affect on the
Stream Info screen.

ReachEff Takes the user to the Treatment Effect on Reaches screen (see
below).
Exit Saves the current chemical option and exits the Chemical Option

Details screen.

The Treatment Effect on Reaches screen is accessed by pressing the Reach
Eff button at the bottom of the Chemical Options Details screen. It
identifies the proportion of ammocetes killed by the chemical treatment.

Treatment Effect on Reaches

Stream Beaches: Efficiencies bv Age:
2 BELOW NEW BAR -OLD WEIR SITE Qe hem
3 ABOVE NEW BAR.-OLD WEIR SITE

Portion Treated: |1 Gat

[FY-"RNE R AN St

The fields and buttons available from the Treatment Effect on Reaches
screen are:

Stream Reaches Lists all reaches in the current stream configuration.

Portion Treated Indicates the proportion of lamprey habitat affected by the
treatment.

Efficiencies by Age Treatment efficiencies for individual age classes. The usual
settings are .99 for high, .98 for medium and .95 for low efficiency.

Treat Specifies that the reach is to be treated.

Don’t Treat Removes a reach from treatment by the current chemical option.
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Set ChemEff Allows the user to enter a new chemical efficiency value for all age
classes. If you want to edit the chemical efficiency for a given age
class only, click on the ChemEff value that you want to edit and
enter the new value that reflects the portion of the age class killed.

The Spawner Allocation to Reaches screen in ISIS, which can be activated
by clicking on the Spawners command button on the Activity tab, is
identical to the one in LCSS. Use this option to specify what proportion of
the spawners entering the stream should be allocated to each reach within
the stream configuration.

Spawner Allocation to Reaches

Lake: [Guperior _____|Steam: [ 10705] AMNICON RIVER ]

St Confi ion:  [St with batriet ]
]

Total Habitat Area: 118601

7 Broportion.

< This screen allocates spawners from streams to reaches. To allocate
spawners from basins to streams, go to the Lamprey Allocation
option in LCSS (pg. 4-31).

As a general rule, the spawner allocation is set proportional to the habitat
area in each reach (as in the example screen above). This calculation can
be done automatically by clicking on the Proportion command button at the
bottom of the screen. In some cases, however, an operational barrier may
block the passage of lamprey upstream and the values in the Allocation to
Reach column will be 1 (below the barrier) and O (above the barrier). The
sum of allocation values for all reaches within a stream configuration
should equal 1, otherwise the system will be inconsistent in its allocation
by allowing more (or fewer) spawners to spawn than arrived in the stream.

The combination of the spawner allocation and the trapping mortality
determines the number of spawners arriving in the reach. More details on
how these numbers are used can be found in the model description in
Appendix A.

You can simulate the placement of traps in reaches by using the Traps tab.
The screen allows users to define the placement, efficiency, and cost of
both default and non-default traps on the currently selected stream
configuration.
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Stream Parameters

US> A default trap placement is specific to the stream barrier activity
being simulated on the stream to which the trap is added. For
example, if the stream barrier activity for the Amnicon River is set
to “no barrier or barrier not active”, the trap is present whenever
this stream barrier activity is simulated.

[ Whereas default traps are linked to stream barrier activity, non-
default traps are defined for a given year and are not dpendent upon
the stream barrier activity being simulated.

Fields and buttons for setting default traps with the Traps tab are:

Stream Barrier Activity From the drop-down list, select one of the stream barrier

Reach
Description

TrapEff

AnnOpCost

Barrier

Overview

activities created for the current stream configuration.

Drop-down list of reaches available for placing traps.

Enter a description of the trap.

Enter a value between 0 and 1 to represent the efficiency of the
trap. A value of 0.2, for example, specifies that 20% of all lamprey
swimming by this trap (to the reach on which the trap is located and
all the reaches above it) are caught.

Enter the annual cost to operate the trap.

Barrier (if there is one) with which the trap is associated. Choose
from the drop-down list provided.

Activates a summary screen which shows the cumulative effect of
the default and non-default traps (see Summary of Trap Activity
in LCSS, pg. 4-40).
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Copy Uses one of the “template” traps to create the new trap.
Add Inserts a “blank” entry.
Remove Removes the currently selected trap.

Fields and buttons for setting non-default traps with the Traps tab are:

YearTrapOn  First year the trap is active.
YearTrapOff  First year the trap becomes inactive.
Reach Specify the reach on which the non-default trap is placed.

TrapEff Proportion of lamprey the trap catches in the reach where it is
placed and all the reaches above it.

AnnOpCost  Annual operating cost for the trap.

Add Adds an entry to the Non-default Traps table.
Remove Removes the currently selected entry from the Non-default Traps
table.

Non-default trap placements act in addition to traps placed in the stream by
default. However, when a stream barrier activity changes (and with it the
default trap placements), all of the non-default placements are reset.

SMRT  The Sterile Male Release Technique (SMRT) tab is used to set the non-
default release of sterile males to the currently selected stream. The default
SMRT releases can be set on the Activity tab (see the Default command
button, below).

Stream Parameters
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Spawners

Fields and buttons on the SMRT tab are:

SimYear The year of sterile male release.
SMCount The actual number of sterile males released.
SMRelRt The ratio of sterile to non-sterile males. For example, when the

SMRelRt in 1995 is 2, then 2 sterile males are released for every 1
non-sterile male.

Overview Activates a screen that provides a summary of the SMRT program.

Defauit This command button switches you to the Activity tab to set defauit
SMRT allocations.

Add Adds release entries for the currently selected stream.

Remove Removes release entries for the currently selected stream.

The Spawners tab allows specification of the annual spawner allocation to
the stream.

Stream Parameters

SpawnCountTotal
100

100

78

100

90

This screen provides both numeric and graphic representation of spawner
abundance. The Spawner Abundance table allows entry and modification
of the characteristics (e.g. number and sex ratio) of spawners entering
streams from basins, and is independent of the transformer production in
the selected stream (see also basin-to-stream spawner allocation in LCSS,
pg. 4-33).

To add a feedback. with stream transformers adding to the “basin”
spawners, mark the Return Spawners check box. ISIS will enter a value
into the Propn. Return field that identifies the proportion of transformers

ESSA Technologies Lid.
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from the selected stream that return to the same stream to spawn. This

value comes from the basin-to-stream spawner allocation calculation in
LCSS (see pg. 4-33). The number of returning spawners is calculated
using the number of transformers produced 2 years prior to the current
simulation year (which allows for their residence in a lake), and
incorporates the appropriate basin mortality rate.

Although the Propn. Return value on the Spawners tab can be modified to
simulate various hypothetical situations, the original value cannot be
recovered unless you import a new stream.

I CAUTION: To avoid the possibility of conflicts, currently loaded
stream-basin-stream allocation data are deleted prior to loading a
new set of values. This may cause some streams to behave
differently following the loading of an unrelated stream (due to
different survival rates of parasitic phase lamprey and different
proportions of returning spawners).

The system does not require all of the years of the simulation to be entered.
The spawner levels are kept constant based on the last known value (eg. if
the number of spawners is set to 100 for 1965 and then to 78 for 1975, the
number simulated from 1965 to 1974 will be 100 and from 1975 on will be
78). If there are no values entered for the spawner numbers prior to the
currently simulated year, the lake default is used.

The yearly records can be added or removed using the Add and Remove
command buttons.

The size of the spawner run can be reviewed graphically by clicking on the
Table/Graph command button. ‘

Stream Parameters
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Treatments

Model Menu

In the graph of spawner abundance, the horizontal x-axis ranges from the
year entered for Sim. Start Year to the year entered for Sim. End Year.
These values represent the start and end years for the simulation. The
vertical y-axis depicts spawner abundance. The y-axis maximum is set to
the value in the Graph U.Bound field. If no value is entered by the user
in the Graph U. Bound field, the system will use the largest value found
among the data displayed as a default upper bound for the y-axis. The y-
axis minimum is set to 0.

Only the data for the basin-to-stream spawners (ie., data entered in the
table) are displayed on the graph since the value for the returning spawners
is dynamic and unknown prior to the simulation.

The Treatments tab is used to view and modify chemical options for the
currently selected stream. Access to this tab will be denied if the Treat flag
on the Stream tab is not set to “true” (see pg. 5-6).

Stream Parameters B
VAR

Treatments for particular simulation years can be added and removed using
the Add and Remove command buttons. Users can view and modify
chemical option values by activating the Chemical Option Details screen
(Chem Opt command button) (see pg. 5-11).

The Model Menu contains two options.

Run
View Results
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Run

View Results

The Run option executes the model for the currently selected stream.

The View Results option allows you to view results of any of the saved
runs.

The lamprey model can be run for the specified range of years. Each
instance of the run is stored under a separate heading. The Simulate
Stream screen can also be activated from the button bar using the icon.

Run Description for [S 10705]
New Run

The model simulates all of the aspects of the stream including the barriers,
SMRT and Traps.

The last of the major components of ISIS can also be accessed from the
Model Menu. It allows review of the results of runs stored in the database.

Here you can compare results of simulations of streams with one another
or with assessment data (if available). The Run Results Setup screen can
also be activated from the button bar using the icon.

« Run Results Setup

RunDat Is : o)

1S 10122] LAUGHING WHITEFISH 1958-1990 New Run
[S 10122] LAUGHING WHITEFISH 1958-1930 New Run
[S 10122] LAUGHING WHITEFISH 1958-1990 New Run
[S 10122] LAUGHING WHITEFISH 13958-1890 New Run
[S 10122] LAUGHING WHITEFISH 1958-1930 New Run
[S 10705] AMNICON RIVER 1958-1975 New Run
S 10705] AMNICON RIVER 1958-1980 Run 1
: 705] AMNICON RIVE

: 'Graphs {select one or mor
|| Stream Transformer Production

{Avg (Unweighted] Ammocete Density Dep. Survival

Spawn Hun Size

Run Data Sets Lists all of the runs available in the database. One or more runs
can be selected for graphical display.
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Display Type Allows you to display the results either side-by-side or as overlayed
graphs.

Lists all of the parameters available for graphing (select one or
more). Each of the parameters selected will be displayed for each
of the data sets selected.

Graphs

View Graphs Displays or refreshes the graph display (see below).

Exit Returns the user to the Main Menu bar.

Run Results View

Help Menu

Stream Transformer
Production [S 10705] New
Run

Spawn Run Size [S 10705]
New Run

1Mo
25000
200004
10000}
150001

1000+

50003

" "o
145 L4

e
hd

Help is available in two ways: through the Main Menu and from each
screen. The help provided through the Main Menu is indexed for easy
reference and can be best used for getting an overall view of the system and
for finding out about specifics of the program's operation.

The help available from the screens is context sensitive and is related
directly to the options available from the screen. This type of help can be
invoked using the <F1> key while using the system.

The information presented through both options is identical. The index
presents a top-down view of the system, beginning with general topics and
moving to more detailed information about ISIS. The context-sensitive help
goes directly to the section of the Help Menu most applicable to the current
sCreen.

The help files follow the standard Microsoft Windows Help format.

FSSA Technoloadies Lid.
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Appendix A: Sea Lamprey Model

Overview of Model

The lamprey simulation model of the IMSL DSS describes both the lake and the stream phase of
the life history of sea lamprey. The spatial structure of streams, reaches and lamprey basins is
described in Section 2.0 of this manual. The stream reach model describes the production of
ammocetes and transformers, and the effects of control options on stream phase lamprey. The lake
phase model accounts for the survival and allocation of parasitic phase lamprey in the lamprey
basins. The model describes the following components of lamprey dynamics:

Stream Phase:

1) allocation of spawners among stream reaches and the effects of barriers on the
allocation;

2) effects of traps on the size of spawning populations;

3) lamprey fecundity and the effects of sterile male release on spawning recruitment
to age O0+;

4) ammocete migration to downstream and lentic reaches;

5) survival from egg to age 0+,0+ to 1+, ...9+ to 10+ ammocetes;

6) growth of ammocetes;
7) transformer production; and
8) mortality due to chemical control treatments.
Lake Phase:
D) allocation/movement of transformers (adults) to lamprey basins';
2) sex ratio of adult lamprey;
3) survival from transformer to adult parasitic phase; and
4) allocation of spawners from basins to streams.

The term lamprey basin is used here to refer to the area over which a population of adult lamprey is distributed.
This spatial unit may or may not correspond to geomorphic lake basins. In practice, the lake basins relevant
to the spatial dynamics represented in LCSS likely correspond to the geographic range of primary prey
populations.
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The parameterization of these life stages in the model is based on assessment data, and on
parameters in the prototype Lake Ontario lamprey model (see Greig et al. 1992 for review).
Density-dependent hypotheses of ammocete survival, growth and transformation rates are
described by the model. LCSS users can change the parameters of all model functions to simulate
density-dependence and control the strength of each hypothesis.

Interaction of model with LCSS Interface

The Lamprey Control Selection System (LCSS) allows the user to apply control options to
lamprey populations that are simulated by the model that is linked to it. Users input data into the
LCSS (such as treatment characteristics, population parameters, stream habitat data) that describe
the dynamics of lamprey populations. The model then uses this data to simulate the annual
population dynamics of lamprey in all reaches within the IMSL database. These simulations can
be compared to available assessment data to further refine the input parameters. These simulations
can be compared to available assessment data to further refine the input parameters. LCSS also
allows for the interactive selection of controls (TFM/Bayer treatments, traps and barriers) year
to year, or automatically (for TFM/Bayer treatments) for long-term runs. An overview of the
sequence of calculations within the LCSS lamprey model and the model's dynamic interaction with
the treatment scheduler are illustrated in Figure A.1.

LCSS saves the simulated, annual population structure (ammocete density by reach and age) of
both treated and untreated streams/reaches in the database. Users can view the results of LCSS
simulations in either graphical or tabular report in MS Access.

Stream Inventory and Size of Larval Habitat

Streams are composed of reaches of larval lamprey habitat as described in Section 2 of this
manual. Reaches have been established for portions of streams that have been treated as discrete
units at some time in their history. These reaches include significant stream tributaries and
sections. Lamprey barriers also separate reaches within streams. Some river systems where large
tributaries are always treated as single discrete units are represented as separate streams to
simplify the reports and summaries (e.g. Oswego River System - Lake Ontario and the Cheboygan
River System - Lake Huron).

The estimates of the quantity and quality of available habitat in each reach are used to establish
the effective amount of Type I or optimal larval habitat. The total area of each reach is defined
by its length and width. Reach length is defined as the average length of stream populated by
ammocetes. In some streams, habitat length has been measured directly during random transect
surveys. For other streams, the average length of the treated reach is used as a surrogate for
habitat length. Likewise, reach width has been measured directly for some streams, while in other
cases, stream widths have been estimated from a relationship between width and discharge
(Leopole and Maddock 1953) and parameterized with available data:
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Width = 9.82 x Discharge®?

Average treatment discharge is used as a surrogate for mean annual discharge where estimates of
mean annual discharge are not available. Total area of the reach is estimated as the product of
length and width.

TotArea = AvgReachLen x ReachWidth

The total reach area is adjusted for the quality of larval lamprey nursery habitat available. The
proportions of Type I (i.e. optimal, PHQual) and Type II (i.e. acceptable PMQual) habitats have
been measured for some streams during random transect surveys. The average values for these
habitat proportions have been applied to reaches where these detailed surveys were not available.
The U.S. Agents have separated Type I and II habitats and density estimates in their random
transect surveys. There is a significant difference in the average density of ammocetes between
these habitat types. The average ratio of Type II to Type I densities (Type II = 0.2 Type I) has
been used as a weighting factor to adjust the Totdrea to an estimate of effective Type I or optimal
habitat.

HabArea = TotArea x PHQual + TotArea x PMQual x 0.2

The Canadian agents have not separated Type I and Type II habitats in their quantitative estimates.
The average habitat quality proportions found in the U.S. surveys have been applied to the
Canadian streams.

The estimates of habitat quality used were for whole streams, and were applied to all of the
reaches within the stream (habitat quality estimates are available by reach and should be used to
refine these values). The areas for lentic reaches are estimated from historic treatment and
assessment data. Where available, survey and treatment data have been used to estimate the
effective optimal habitat area within the lentic reach.

Spawning habitat is not explicitly defined as a model parameter. Lack of spawning habitat in
lentic reaches or in some reaches below barriers is modelled by reducing the egg survival rate to
zero (EggSurvRt = 0).

Lamprey Basin Definitions
Lamprey basins have been assigned on the basis of current understanding of parasitic- phase

population patterns. Alternative basins can be selected for running historic or future simulations
with the LCSS. The default basin for all the lakes is the whole lake. A total of 11 lamprey basins
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have been defined for the system including 4 in Lake Superior, 3 in Lake Huron, 2 in Lake
Michigan, 1 each in Lakes Erie and Ontario. Streams are assigned to each basin on the basis of
the proportional alloction from basin to each stream (PropToStream). In the current version,
spawning phase lamprey are allocated to individual streams from only one basin. Likewise, the
current version allocates transformers from one stream to only one basin.

Spatial Dynamics: Moving Spawners to Reaches, Transformers to Salmonid Stocks

It is important to understand the movement of lamprey populations from natal (origin) streams to
lamprey basins (lake areas inhabited by salmonid stocks) and subsequently to spawning
(destination) streams before using the LCSS. The system has been designed to allow flexibility
when partitioning the effects of lamprey populations in lakes and allocation back to streams.

Figure A.2 illustrates a conceptual model for thinking about lamprey movement. Part A represents
movement of transformers from origin streams to lamprey basins and of spawning-phase lamprey
from basins to destination streams. The arrows in the figure should be thought of as representing
not just the basins where transformers end up but also the proportion of transformers leaving each
stream which will inhabit each basin. Some origin streams may produce transformers that will
impact the salmonids in one basin only (e.g. streams 1 and n in Figure A.2_A) while others may
impact more than one basin (stream 2, Figure A.2_A).

Spawners from any one basin are likely to enter any one of several destination streams, and some
streams may attract spawners from more than one basin. The St. Mary's River is a good example
of a stream which may impact on and receive spawners from multiple basins. The lamprey
population in any stream that lies near the boundary between two distinct (or nearly distinct)
basins may also interact with more than one basin. The arrows in the figure illustrate the linkages
from origin streams to basins and from basins to destination streams. Reading across each row,
the actual entries in the matrices are the proportion of lamprey moving from the origin stream to
each basin (left matrix) or from a basin to destination stream (right matrix). The sum of all entries
across each row must be equal to one. '

This structure was designed to offer full flexibility in allocating lamprey populations and in
assessing the effects of this spatial allocation on targets and control selection. However, the
structure is limited in that the allocation of spawners is fixed for all years of the simulation and
cannot respond to annual larval population abundance or to stream treatments as determinants of
recruitment.
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Figure A.1: LCSS Interactions with the IMSL lamprey and fish community models
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Figure A.2: Conceptual model for representing the spatial movements of transforming -
ammocete and spawning adults between streams and lake lamprey basins.

Simulating the Characteristics of the Spawning Population within Reaches

Determination of characteristics of the spawning population within reaches is composed of two
basic steps:

o determining spawner allocations to streams and to reaches within streams
(including, where applicable, the effects of the barriers and traps); and
o determining the size of the individual spawning lamprey.
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Lamprey Basin to Destination Stream Allocations

The number of spawners from a given basin allocated to an individual stream is defined by the
parameter PropToStream for the selected lamprey basin structure. This proportion is calculated
outside the current system based on the rank of the stream as a primary, secondary, or non-
recruiting (dormant) spawning stream and the stream discharge. Primary streams receive 90%
of the spawning run, secondary streams get 9.5%, and the remaining dormant streams get 0.5%
of the total spawning allocation. Within each class, the allocation is based on the proportion of
total discharge from an individual stream. Average treatment discharges have been used as a
surrogate for spring or annual discharge values. The PropToStream for any individual or group
of streams can be manipulated through the LCSS with the system normalizing the remaining
values so that the total allocation is equal to one. The PropToStream selected affects all years
of simulation for that scenario.

The resulting number of spawners allocated to a given stream is:

SpawnCountTotal |, = Zallbasins PropToStream, . % SpawnCount, .

Basic Rule for Allocating Spawners to Reaches

Most lamprey streams in the Great Lakes basin only have one lamprey-producing area that is
treated on a regular basis. Some streams, however, have more than one discrete lamprey-
producing area. Discrete lamprey-producing areas can be reaches along tributaries of streams,
complete tributaries, or lentic areas. These production areas of streams considered by the LCSS
model, and therefore subject to independent treatment simulation/scheduling, are referred to as
reaches. For those streams that have discrete lamprey-producing reaches, each reach will receive
a portion (SpawnCount, ., of the total number of spawners (SpawnCountTotal , ) that are
allocated to the stream according to a reach-specific proportionality constant (SpawnAllocFtry, ;.,)-
It is assumed that the reach receiving spawners will support the recruited ammocetes.

SpawnCount = SpawndAllocFtr x SpawnCountTotal ,

str,rea str.rea

The proportionality constant is determined empirically, and is stored in the database record for
the reach. User-specified criteria such as streamflow, habitat area, habitat quality, or judgement
(observed ammocetes) will determine the proportionality constant. The default values of
SpawndAllocFir,, ., in the current system are based on the proportion of total areas in each reach
ot the total stream. Unlike spawner allocation to streams, the allocation to individual reaches can
be varied by year to simulate the effect of barriers.

A-7 ESSA Technologies Ltd.



Appendix A LCSS: User Guide

Effect of Barriers and Allocation of Spawners to Reaches

The activity of barriers modifies the allocation of spawners to reaches. Each state of a barrier
(e.g. active, inactive, leaky) or distinct combination of these states for multiple barriers (e.g. for
two barriers, both active or the first active and the second inactive, etc.) dictates a new allocation
of spawners to reaches. These are stored separately in the database and used instead of the default
allocation (all barriers inactive). The SpawnAllocFtr,, ,, for reaches above active effective barriers
is 0. The spawners in the stream are reallocated to the reach(s) below the barrier. Existing barriers
that do not work use the default SpawnAllocFtr,, ., for that stream.

Effect of Traps on Size of Spawning Populations

While barriers redirect spawners, the traps actively remove part of the spawner run. Individual
traps are placed on reaches, thus affecting all of the spawners going to reaches upstream of the
trap as well as the spawners of that particular reach.

The effect of traps on each reach, TrapEff,, ., is calculated by combining the effect of all traps
downstream of that reach. :

TrapE]:fSlr,reﬂ =1 - Hdownstream rea (1 - TrapEfftmp)

The effect of trapping on the number of returning spawners to a reach (SpawnCount,, ,,,) 18
described by:

SpawnCount,, = (1 - TrapEff, ) % NewSpawnAlloc, . * SpawnCountTotal

Size of Spawning Lamprey

The size of the spawning lamprey afffects recruitment through fecundity. In the absence of a
dynamic fish and parasitic-phase feeding model, this model assumes uniform growth of adult
lamprey to an end-of-feeding season mean weight (PreSpawnWeight uprey vasin) OF 0.2 kg. The end-
of-feeding season weight in the lamprey model is lamprey basin specific and can be adjusted to
reflect differences among the basin populations. This weight is then reduced by 15 percent
(PreSpawnWLOSS umprey asin)  PYIOT 1O spawning to produce the lamprey spawning weight
(SpawnWeight usrey sasin)-  The length of spawning female lamprey (SpawnLenFem e, pasin ) 15
predicted from SpawnWeight ,...x pasin-

SpawnWezghtlmpreyhmm = PreSpawnWezght!ampreyhasm x (1 - PreSpawnWLosslampreyhmm)
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SpawnLenFem = (SpawnWeight x Len WeightMult)LenWeigh(Exp

lampreybasin lampreybasin
where:
LenWeightMult = 2.47E7 and
LenWeightExp = 0.397

SpawnWeight, SexRatioFem, SpawnLenFem, and EggsFem, are all calculated for each basin. If
multiple basins contribute lamprey to a single stream, they are combined using weighted averages.
All are calculated in this manner because the relationship between weight and length is non-linear,
so calculating length after combining the weights would produce a different result.

Estimating Ammocete Recruitment to Age 0+

Simulating the recruitment of lamprey to the stream population within a reach involves four basic
calculations:

. determining, from the population sex ratio, the number of male and female
Spawners;

. determining, from estimates of lamprey fecundity, the expected egg deposition by
a single spawning female;

. estimating the number of successful spawns as modified by a user-specified
scenario of sterile male release (SMRT); and

. determining, from the expected survival rate of eggs to age O+, the number of age

0+ ammocetes recruited to the reach ammocete population.

Sex Ratio

The sex ratio of spawning phase lamprey from a given basin is determined by the sex ratio of the
transformers contributing to the population. The sex ratio of spawning lamprey in an individual
stream is equal to that of the entire lamprey basin (i.e. not variable over the individual streams
within a lamprey basin. The LCSS uses the coefficient SexRatioFem,, to determine the number
of female spawners within each reach to which spawners are allocated.

SpawnCountFem = SpawnCount x SexRatioFem

str,rea str,rea ir

Effects of Sterile Male Release

Two numbers specify the SMRT release: SMCount and SMRelRt (release rate). SMRelRt is the
ratio of sterile to normal males in the stream. The number of successful spawnings are reduced
in direct proportion to this ratio. SMCount is the number of sterile males released in the stream.
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SMReIRT is calculated for SMCount and the predicted number of normal males in the stream. If
both numbers are present, SMRelRt takes precedence. If neither is specified, a default value
associated with each spawner allocation criteria set (SpawnAllocFtry, .,) is used.

Placement of sterile males either as a fixed number or defined ratio (SMCount,, or SMRelRt,,) in
a stream will reduce the number of successful spawners. The number of successful spawning
females of a stream into which sterile males are released (SuSpawnFemy, ,.,) 18 calculated by:

SpawnCountFem

str,rea

SuSpawnFem =
i sirres (1 + SMRelRt)

If there are no sterile males released into a reach (SMRelRt,,, = 0) then

SuSpawnFem = SpawnCountFem

str,rea str.rea

Please note that the sterile males are kept as a rate which does not change if traps are present. In
effect, this simulates SMRT release to the mouth of the river during spawning runs and assumes
that sterile males are affected by the traps in the same way as the rest of the lamprey.

Fecundity

Fecundity is determined with the relationship between SpawnLenFem,, (mm) and egg production
in the prototype Lake Ontario simulation model. This preserves the ability to simulate potential
lake environment or prey species effects on ammocete recruitment. The total number of eggs
allocated to a reach (EggsDen,, ,.,) is equal to fecundity times the number of females allocated to
the reach (SpawnCountFem,, ,,). As with population size in reaches, eggs are tracked as density.

EggsFem = FecunRegCoef x SpawnLenFemlampreybasm + FecunReglnter

where:
FecunRegCoef = 205.6
FecunReglnter = 12017

EggsFem » SuSpawnFem

strorea

EggsDenstr,rea ) HabArea

Please note that EggsFem is calculated on a basin-by-basin basis and is then combined as a
weighted average to give stream values.
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Age 0+ Density

Ammocete recruitment from egg to age 0+ is calculated by multiplying the total number of eggs
produced in a reach by an empiric survival rate:

AmmDen = EggSurvRate x EggsDen

str.rea,0 str.rea strorea

Growth and Survival of Ammocetes
Ammocete Migration

Ammocetes can be moved downstream between reaches in order to simulate processes populating
lower reaches and lentic areas. Ammocetes migrate only to a reach below the current one. The
number of migrating ammocetes is calculated before mortality or transformation has been applied.
Migration can be defined for all age classes, but does not affect the young of the year (YOY). The
average population length at age for a reach does not change within migration; only the number
(density) is altered.

The additional recruitment resulting from migration is considered in all of the density-dependent
functions for survival, growth and transformation and sex ratio. Chemical options affect migrated
ammocetes as they would the resident population.

In the base system, the rate of downstream migration by age has been to 0 for all reaches except
those above lentic reaches. The rate of migration to lentic reaches is 0.1 for all ages.

Ammocete Density

Ammocete abundance at age in a reach is accounted for as density, that is, the number of
ammocetes at age divided by the area of habitat of the reach suitable for ammocetes
(HabArea,, ,,,). Total density (AmmDenTotaly, ) is the sum across ages, but does not include the
current year's age 0. The effects of ammocete migration are included in this sum.

HabArea = HabLen x HabWidth

str.rea str.rea str.rea

AmmMigrOut AmmMigrin

strrea,age sirrea,age )

HabArea

strorea

- +
AmmDenTotal Zage (AmmDen . qc
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Ammocete Length

The growth of ammocoetes is modelled independently for all reaches and is dependent on density
in that reach. The pattern of length at age is predicted to follow the von Bertalanffy growth
model. The general form of the von Bertalanffy growth equation is:

AmmLenstr, rea,age L. X (1_e-KSlr,rea X age)

where L. = theoretical maximum asympototic length of ammocoetes (default = 200

mm), and
K = the Brody growth coefficient.

Figure A.3 presents the relationship between length and age for different values of K following
the growth model. K has been estimated for individual streams based on the length at age 2 +
(Figure A.4). Average values for size at age 2 have been used where data were not immediately
available. ’

von Bertalanffy Growth Curve
Linf=200
200
K=0.475
g 150 T
E
R (e
§ K=0.14
B0 4/ e
0 ;
0 2 4 6 8 10
Age

Figure A.3 Simulated ammocoete growth in
length for minimum and maximum
observed values of K and
L.=200mm.
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Figure A.4 Relationship between mean length at
age 2 and K.

The rate of growth determines the age of first transformation by.determining the age at which the
size threshold is met. The size threshold for metamorphosis is estimated to be 120mm. The age
at which a year class begins transformation is the age at which its mean length is equal to 120mm.
This threshold parameter (AvgLenlstTrans) can be modified to better represent the distribution
of size within a yearclass as data becomes available. Figure A.5 relates the age of first
transformation to the value of K. The growth of an individual age class will be determined by its
growth history, that is, the rate of growth (K) in each year of life. The value of K is dependent
on density.

Age of First Transformation (yrs)

0.1 0.2 03 0.4 0.5
K - Brody Growth Coefficient

Figure A.5: Relationship between age of first
transformation (mean length = 120
mm) and K.

A-13 ESSA Technologies Ltd.



Appendix A LCSS: User Guide

The density-dependence in growth is modelled using a 2-point SLP function with the Brody
growth coefficient K being dependent on total ammocete density, AmmDenTotal (see the end of
this section for discussion). The two points used are (AmmDenl, AmmKI) and (AmmDen2,
AmmK?2). The variable AmmLeny, ,,, .., holds the average size of an ammocete age class at the end
of a growing season. Therefore, the size for age 0 is calculated by:

AmmLen =L_x (1 -e®"h

str,rea,age

Older ages are subject to varying densities, and therefore varying values of the Brody growth
coefficient. Ammocete length is calculated incrementally by:

_ -K xage) -K
= x el g¢) x -
AmmLenm’m’age AmmLenm’rm%,e_1 + L %X e (1 e ™)

where: AmmLeng, ., .1 1S the length at the beginning of a given season, and
AmmLeny, ,,, .. is the length at the end of a given season.

The following equations are derivations for the annual ammocete length increment:

Lm (1 - e“k(nge+l)) - Lm (1 _ e'kagE)

- Lw ((1 — e‘k (age + 1)) _— (1 — e'k age))

- Loo (e -k age _ e -k (age+1))

- L,x, (e~kage - e*k (e~kage))

=L_e*® (1 -e™

Ammocete survival

Ammocete survival for ages O+, 1+, ..., 9+ to the next age class in a reach at low total
ammocete density is estimated by multiplying an empiric annual survival rates (AmMmSUrvy, eq age)
by the ammocete year class strength (AmmDen,, o ..)- The density-dependent survival rate,
AmmSurv,, ., is calculated using 2 point SLP functions with the survival rate dependent on total
ammocete density. Points used are (AmmSurvDenl, AmmSurvRtl) and (AmmSurvDen2,
AmmSurvRi2).
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AmmMigrOut

str,rea

AmmMigrin
"

strrea

= x
AmmDen, ir.reaage AmmSurv_ o rea.age AmmDen_ rrea.age-1 Habdron
strrea

The final age class, 10+, is assumed never to transform and is dropped from the calculations.

Simulating the Effects of Chemical Treatments

The effectiveness of TFM and Bayer is reach and age specific. The surviving number of
ammocetes in each age class following chemical treatment (AmmbDen,, .., ) 18 calculated by
multiplying the current number of ammocetes in each age class by effectiveness factors for TFM,
or TEM and Bayer (ChemEff,, o) and the portion of the reach treated (ChemTreatPart,, ).
Application time (spring vs fall) will determine treatment effectiveness for 0+ ammocetes. The
effectiveness factors can be defined by treatment windows to account for this seasonal variation.
Treatment effectiveness has been estimated by treatment personnel as High (99%), Medium (98 %)
or Low (95%) for each chemical option for each treatable reach. In the current model, the same
effectiveness values are applied to all ages (including age 0) and to all windows for a given reach.

AmmDenKill = ChemTreatPart X ChemEﬁ; x AmmDen

str.rea.age str,rea tr,rea,age str,rea.age

AmmDen = AmmDen - AmmDenKill

str.rea,age strrea,age str.rea,age

where:
AmmDenKill,, .., ... = kill density by age.

The density for reaches of which only a part was treated is assumed to become uniform before the
next year.

Simulating Transformation to the Parasitic Phase

The model uses a four stage transformation model with the user-determined yearly transformation
rates, TransRi,,, (€.g. 10%, 33%, 66%, 100%). Each transformation rate applies to the
remaining population size (AmmDeny, ,,, ...) for a specific age class, as is shown in Figure A.6
below. Transformer production is accumulated across all of the transforming age classes:

TransDen = TransRt x AmmDen
str,rea,age stage str.rea,age

TransProd = Z TransDen x HabArea
str.rea age

strrea,age str.rea

A-15 ESSA Technoiogies Lid.



Appendix A LCSS: User Guide

As described above, the transformation is triggered by a global parameter, AvgLenlstTrans,
average length at first transformation. All of the transformers are considered to be the same basin-

specific size, PreSpawnWeight,,g;,.

Cummulative Proportion of Year Class

Year of Transformation

Figure A.6: Cummulative proportion of a year
class transforming where year 1 =
age of first transformation and the
yearly transformation rates are 10%,
33%, 66%, 100%.

Sex Ratio

Transformer sex ratio is dependent on total density, AmmDenTotal, and is modelled using a 2
point SLP function with the proportion of females dependent on density. The two points used are
(SexFemDenl, SexFeml) and (SexFemDen2, SexFem?2). In the current model, the SexFem! and
SexFem2 values are equal and set to the current basin average sex ratios.

Allocation to basins

Each stream contributes transformers to one or more basins. The total number of transformers
entering a basin is calculated by:

= x i
Transcountbasm Zstr,rea TranSPrOdslr,rea PrOpTOBasznstr,basin

Transformer sex ratio for a basin, TransSexRatioFem,,;,, is calculated using a weighted average.
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Simulating Adult (Parasitic Phase) Interactions
The transformers leaving the reaches, which now become "origin" streams, t0 become a part of
the adult parasitic population that preys on the salmonid stock. Transformer survival to the

parasitic phase, PPLampMort,,,, is constant for the basin, and the sex ratio, PPSexRatioFem,,,,
does not change:

PPCount. = = PPLampMort, _ x TransCount
basin basin bas

in

PPSexRatioFem basin = TransSexRatioFem

basin

In the current model, PPLampMortbasin = 0.5.

Density Dependence and SLP Function

As mentioned earlier, many of the ||
ammocete characteristics are density
dependent. The magnitude of density
dependence is determined using a 2 point
SLP function. The two points used in this form 1

example are (AmmDenLow, AmmValLow), s - 72\

and (AmmDenHigh, AmmValHigh). At

density below the lower threshold -~
(AmmDenLow) the density dependent value
is equal to AmmVal Low. Between the two
threshold  densities the value is ‘ ;
interpolated. Above the upper threshold 10 2 2
(AmmDenHigh) the density-dependent Total ammocete density (#/m?)

value again becomes constant at Figure A.7: General form of the hypothesis function to
AmmDenHigh. Even though LCSS uses a determine ammocete dynamic rates versus
2 point SLP function, in general the SLP total ammocete density.

functions can contain any number of

points.

form 2

Figure A.7 shows the general form of the hypothesis function used to determine ammocete
dynamic rates versus total ammocete density. Form 1 shows the effect of upper and lower density
thresholds. Form 2 shows a constant rate where the low and high values are equal.

The density thresholds for all of the SLP functions have been initially set to the same values. The
first threshold is set to equal the geometric mean density plus 2 standard deviations (10/m?) as
estimated from Lake Superior quantitative assessment results. The second threshold is at 3
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standard deviations above the geometric mean (20/m?). The effect of these thresholds is to set
most rates constant under the current regime of treatments and densities. The lower values for all
of the rates have been arbitrarily set to one half of the current rate estimate.
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Appendix B: Database Structure

Overview of the Database Structure

The review of existing structures was guided by the objective of identifying opportunities for
improving consistency and/or simplification of the database. In many respects, the objective of
simplifying the database structures arose not from specific technical design concerns but rather
from the early difficulties which LCSS users were experiencing in working with some of the
concepts employed within the design. In particular, three areas were targeted as foci for review:

1) the concept of stream configuration (i.e. alternative definitions of the physical
structure, i.e. sets of reaches, of an individual stream);

2) stream barrier activity (closely related to stream configuration); and

3) lamprey basins.

Each of these three components of the database design deal with the representation of spatial
structures within the IMSL/LCSS database. They are central to the overall utility of the system
and their implementation is moderately to highly complex with regard to the relationships between
database tables.

Additionally, the database structures related to budget groups and reporting basins were of special
concern. These features are only partially implemented in the current system and there are
outstanding issues related to their definition and utility within the overall system.

Stream Configuration

The primary focus of the review of the implementation of reach sets was to determine whether the
structure of the database could be re-engineered so as to dispense with the concept and terminology
of ‘stream configuration’ or whether an alternative implementation could buffer general users of the
system from having to work with the stream configuration concept. A clear understanding of the
concept and rationale for our recommendations requires at least an overview of the current
implementation of the stream configuration concept.

The basic function of the stream configuration concept within the IMSL/LCSS database is to provide
a mechanism for representing scenarios which would explore proposed (theoretical) barrier dam
placements for lamprey control. When barriers are placed on a stream, their intended purpose is to
restrict access to spawning and potential rearing habitat. Barrier placement therefore potentially
influences the number of reaches in which it is necessary to simulate lamprey populations within the
stream (multi-reach streams only), habitat characteristics of the ‘reach’ where the barrier is placed,
and the selection/definition of chemical, trap and SMRT options for treatment of any residual
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lamprey populations. The related concept of stream barrier activity deals with the efficiency of a
barrier in blocking upstream passage of lamprey.

The interdependence of the various tables in the database can best be described by presenting the
modifications involved in adding a stream configuration to the present database structure. Some of
the tasks presented here can be accomplished using LCSS, but the changes have been described for
the sake of completeness.

Reaches represent distinct areas of ammocete habitat to be simulated. These may or may not
represent the configuration of ammocete habitat found in a stream. In most cases it is not necessary
to simulate all of the distinct areas of ammocete habitat separately. If a stream is always referred to
as a single unit, all of the areas can be dealt with together. It is important to distinguish between
areas if a density of ammocetes in one area will change differently than in others, due to some
external factors (such =5 a barrier, treatments which sometimes treat only a part of the stream, etc.).

Stream configurations are sets of reaches which taken together represent the whole stream. There
can only be one stream configuration per stream for any given simulation run although its behaviour
may change (see Stream Barrier Activity). Alternative stream configurations are used to represent
different configurations of a stream (e.g. with presence of a barrier simulated or with no barrier
throughout the simulation).

Adding stream configurations is necessary if a new representation of a stream is required (eg. a new
barrier is planned). Let's suppose we would like to add a barrier to an existing simple one-reach
stream. Suppose that the new barrier will split the reach in two. (If it did not we could easily utilize
the existing reach structure.)

The first step in adding a barrier is to add a new entry into the ReachSet table. This step
automatically generates a new ReachSetID value. This value will be used throughout the database
to refer to the new stream configuration.

Next we will add new reach definitions in the Reach table. It is up to us to select values for the
Reach field. These cannot conflict with other values of Reach field for the same Lake and Stream.
In our example, assuming that the original reach value was 1, the new values could be reaches 2 and
3. Reach 2 represents the area below the barrier and reach 3 represents the area above the barrier.
Most of the attributes of the new reaches are the same as for reach 1. The main difference is the
habitat area (Habitat Area), which is now split into two. A description of how to initialize the
population structure in each of the reaches can be found later in the Results Database section.

One situation that may arise when adding a barrier is that the barrier will block lampreys' access to
all of the spawning habitat. This situation can be handled in one of the following ways:

1) Do not allocate any lamprey to any of the reaches (SpawnAllocFtr set to 0). This
will simulate lamprey staying at the mouth of the river and not swimming up the
stream. In this approach the barrier trap, if present, will not catch any lamprey.
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2) Create a "dummy" reach below the barrier and set the egg survival rate (EggSurvRt
in ModelReachParms) to 0. This will simulate lamprey swimming to the barrier,
spawning at the site with no eggs surviving. This approach will allow the barrier trap
to catch lamprey swimming to the barrier. When the barrier is not active, the
allocation to the dummy reach should be set to 0.

The new reaches should also be added to the ModelReachParms and ModelReachAgeParms
tables. The entries will most likely be simply copies of the original reach number 1.

The two new reach numbers must also be added to the table ReachSetReachLL along with the
ReachSetID of the new stream configuration. This step provides a formal link between the new
reaches and the stream configuration. The value of DownStrReach indicates which reach is down-
stream and which is up-stream. The reach flowing directly into a lake should have the value of
DownStrReach set to its reach number. In our example the stream may have reach 3 flowing into 2
and reach 2 into the lake (set to flow into 2). Some of the reaches can be present in more than one
stream configuration. For example, if the original stream configuration was composed of two
reaches, the reach not split would be present in both stream configurations.

Next we should add the actual barrier. The information describing the barrier is stored in the
BarrDef table. As with the ReachSet table, adding an entry here generates another reference
number: BarrID. This number will be used as a reference to the barrier itself. To link the barrier to
the stream configuration we must also add a record to the ReachSetBarrLL table along with the
location of the barrier (the reach immediately above the barrier).

Some of the old chemical options will apply, so we should refer to them in the
ReachSetChemOptLL table with the new ID. (All of the chemical options relevant to the original
(one reach) stream configuration should be applicable since the stream must be able to behave with
the barrier active and inactive (i.e. not yet present).) The ChemEff table’s most important purpose
is to specify which reaches are affected by a given chemical option. A presence of a record with the
appropriate reach number signifies that a reach is affected. A chemical option can affect reaches
from multiple alternative configurations for a given stream. Only the reaches included in the
currently selected stream configuration are actually used. In our example, we should add reaches 2
and 3 to all of the chemical options relevant to the original stream configuration.

Adding values to the ChemEff table generates new values of the ChemEffKey field. These should
be added to the ChemEffAge with the appropriate chemical efficiencies by age.

Next we must check the table BarrEffHyp for existing stream barrier activities relevant to the new
stream configuration. All of the stream barrier activities relevant to the original (one reach) stream
configuration should be applicable since the stream must be able to behave with the barrier active
and inactive (or not present).

In order to use these stream barrier activities, we have to replicate them for the new value of
ReachSetID along with the relevant records in tables SpawnAllocFtr and TrapDef.
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There may be new stream barrier activity which describe activity with the barrier active, which
should be added as well. See the following section for a detailed description of BarrEffHyp and
related tables.

All of relevant existing stream barrier activities should be added to the BarrBarrEffHypLL table
along with the new ReachSetID and BarrID. The value of the field IsActive should most probably
be false since the original stream configuration did not contain the barrier. One of the BarrEffHyp
entries should become the default stored in the ReachSet table. The most likely candidate is the one
equivalent to the default in the original stream configuration.

The next step is setting up new spawner allocation within the stream. Information about that is stored
in SpawnAllocFtr table. The table combines ReachSetID, Reach, and BarrEffHyp values
determined earlier.

If applicable, trap information should be added to the TrapDef and the TrapType tables.

If there were any entries in the ScenarioSMRT, ScenarioTrap, ScenarioEffHyp, or
ScenarioEffHyp these may also have to be duplicated.

As the last step, if the new stream configuration should become a default for the stream, the field
ReachSetID in the table SimStream should be updated to the new value.

Stream Barrier Activity

Stream barrier activities are used to represent the various ways in which a stream can act. Some
examples of these activities are appearance of a barrier, or a partial or a full failure of a barrier. There
can be multiple stream barrier activities defined for any stream configuration and the behaviour can
change during a simulation run.

To illustrate relationships within the database of stream barrier activities, let us manually add a new
stream barrier activity to the database. The new stream barrier activity will describe an active barrier
within the stream we added in the Stream Configuration section above.

Before we proceed with adding a stream barrier activity, we will add a chemical option which would
be relevant to the new stream activity.

First we should add an entry into the ChemOpt table. The chemical option will treat only the part
of the stream below the barrier, ie. only reach 2. A new entry will automatically acquire a value of
ChemOpt. We use this value to add entries to the ChemEff table with only reach 2 (reach 3 is not
treated) which in turn generates a new value of ChemEffKey which is used for entering chemical
efficiencies in ChemEffAge table.
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Next we should link the new chemical option with the reach configuration by adding an entry
containing the new ChemOpt and the new ReachSetID into the ReachSetC hemOptLL table.

Now we can add a new entry to the BarrEffHyp table. The newly created ChemOpt value will
become the default option for this stream barrier activity. If there are also values for the default
annual release of sterile males, they should be added as well.

The new stream barrier activity will have a new set of spawner allocation values. These should be
added to the SpawnAllocFtr with all of the reaches present. The reaches where there will be no
spawners should receive an allocation of 0. All entries for a particular BarrEffHyp should add up to
1, but values less than 1 can be used to simulate lower nesting success (for more information about
spawner allocation and nesting success, see the section on adding reaches to stream configurations).

It there are any traps placed on the stream which are active year after year (eg. a barrier trap) those
should be added to the TrapDef table.

With the new activity set up we can turn the new barrier on. An entry in the ScenarioEffHyp table
will turn the barrier on at the appropriate time in the simulation. The spawner allocation will
automatically change to the new one we just set up. Additionally, should the stream be scheduled
for treatment, the default will be the new chemical option. The new entry in the ScenarioEffHyp
table should only be placed there once. It will automatically be carried forward until another change
is encountered. For example, should there be a time where we wish to simulate a complete barrier
failure, we would need to add another value to the ScenarioEffHyp table with the old stream barrier
activity. The spawner allocation and the default chemical option will revert back to the old ones.

Lamprey Basins

Lamprey basins have a function in the Great Lakes similar to the function of stream configurations
in streams. Lamprey basins partition the Great Lakes into distinct sections. These sections can
represent whole lakes or the parts of lakes to be simulated separately. Not all lakes need to be present
in all of the configurations. If only a part of the Great Lakes basin needs to be simulated, it is more
efficient to set up a lamprey basin configuration containing only those sections needed for
simulation. As with stream configurations, there are many ways in which the Great Lakes can be
partitioned, although only one can be used in any one simulation.

There are four tables representing the lamprey basins. LampBasinDef contains a general description
of the definition itself. This description allows for the identification of the lamprey basin and aids
in the selection of which basin configuration is most appropriate for the simulation.

The table LampBasinSubDef lists all of the sub-basins included in the configuration. If we were
to simultaneously simulate all of the Great Lakes we could define an entry for each lake in this table.
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Tables LampBasinToStream and LampStreamToBasin are used to list all of the basins
contributing spawners to streams and all of the streams contributing transformers to basins. There
can be multiple basins from which spawners migrate up a single stream, just as a single stream can
contribute transformers to multiple basins. An example of this is the St. Mary's river which
contributes and receives lamprey from Lake Huron and Lake Michigan.

It is important to ensure that the sum of proportions of spawners for each basin and transformers for
each stream add up to one, otherwise lamprey may be miscounted.

Database Files

The IMSL database was designed to protect static data and to provide a facility for keeping multiple
sets of results generated by minor modifications to a single scenario database (e.g. budget size, crew
combination, etc.). This led to the creation of three separate component databases for each type of
data:

1) Static and rarely changing parameters are stored in the options database;

2) Dynamic parameters subject to change between individual runs are stored in the
scenario database; and

3) Results of the runs are stored in the results database.

1. Options Database

The options database (OPTIONS.MDB) contains data which rarely changes between runs. The
database contains the following tables: BarrDef, Criteria, Lake, Reach, ReachSetBarrLL and
Stream.

The tables BarrDef and ReachSetBarrLL define the barriers and contain the links between the
stream configurations and the barriers (which barriers are placed on which streams).

Tables Lake, Reach, and Stream contain the names and the information about the size and location
of streams.

The Criteria table contains the descriptions of the four evaluation criteria.
2. Scenario Database

The scenario database (e.g. SHIST.MDB) contains dynamic data, potentially subject to change from
run to run. It contains the following tables: BarrBarrEffHypLL, BarrEffHyp, BaseCamp,
BaseCampDeplSiteLL, BudgetChem, BudgetCrew, BudgetGen, ChemEff, ChemEffAge,
ChemOpt, CammInfRt, DeplSite, DeplSiteStreamLL, LampBasin2Stream, LampBasinDef,
LampBasinSubDef, LampStream2Basin, ModelBasinParms, ModelGenParms,
ModelReachAgeParms, ModelReachParms, NetTrapEff, ReachSet, ReachSetChemOptLL,
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ReachSetReachLL, ScenarioAction, ScenarioBarr, ScenarioDescription, ScenarioEffHyp,
ScenarioFish, ScenarioSMRT, ScenarioTrap, SimStream, SpawmAllocFtr, TrapDef,
TrapSummary, TrapType, TripLL, and UserEventOpt.

Descriptions for many of these tables have been presented earlier in this Appendix.

Additionally, the tables BaseCamp, BaseCampDeplSiteLL, DeplSite, and DeplSiteStreamLL
provide information on the three base camps and the deployment sites used from those base camps.

Tables BudgetChem, BudgetCrew, BudgetGen hold the information about resource availability.

Tables LampBasin2Stream, LampBasinDef, LampBasinSubDef, LampStream2Basin control
the stream-to-basin and basin-to-stream allocations

Tables ScenarioAction, TripLL allow for the building of treatment schedules, and UserEventOpt
holds the list of user-defined options.

Tables ScenarioBarr, ScenarioEffHyp, ScenarioFish, ScenarioSMRT, ScenarioTrap provide
non-default selections for specifications.

3. Results Database

The results database (e.g. RHIST.MDB) contains the individual age structured populations, basin
populations and the stream rank list. All of this data is stored in five tables: LampByBasin,
LampByStream, LampByReach, AmmReachPop, and RankStream.

Table LampByBasin contains the information about the size and the composition of all of the basin
populations for the current configuration (definition). The simulation initial conditions consist of
data for one year just prior to the first year of the simulation (new data are added during the
simulation).

Table LampByStream contains the spawning run information for each of the streams in the
simulation. Entries in this table are generated from the basin population sizes and the allocation
found in the LampBasinToStream table described earlier.

The AmmReachPop table contains the age structure for all of the reaches in the simulation. The
initial population structure for a particular year of simulation is stored in records dated one year prior
to that simulation year. Entries for each subsequent year are generated by the model. If new reaches
(and new stream configurations) are added to the scenario database, the initial population structures
must be added to the AmmReachPop table. This is the largest of all tables in all of the IMSL
databases.

Table LampByReach contains the size of the spawner run and the summary information on the
transformer production for the reach.
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Appendix C

IMSL Database
Interface

Main Switch
Board

Appendix C: Database Interface

IMSL database provides a set of screens which ease access to the data
contained there. In many cases it complements the interface present in the
LCSS. Where available (all except for ammocete, parasitic phase and
spawner populations and maps) the interface available through LCSS is
more complete and up to date.

Modifying any of the data accessed through the database (menus or the
native access) should be done with caution since data inconsistencies may
render the database unusable by LCSS. As a general guide, values of
parameters can be modified but modifying data on membership in sets
(e.g., reaches in stream configurations) and element numbers (e.g.,
chemical option numbers, stream numbers, etc.) will cause problems within
LCSS.

The Main Switch Board is the principal screen in the database interface.

Microsoft Access - [IMSL:MainSB]

Great Lakes Fishery Commission

d LM.S.L. Database

Start or Return to
the LCSS

Switch to MS Scenario Description

Access Native
Interface

Enter of click to access the View Data Switch Board

This screen allows access to two main areas within the database interface:
Data Views containing the input data, and LCSS Reports containing
results. These areas correspond to two buttons on the main screen in the
database interface: View Data and LCSS Reports respectively.
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Data Views

Other buttons on the main screen are:

Start or Return to the LCSS transfers you to Lemprey Control Selection System
(LCSS).

Switch to MS Access Native Interface  gives you access to the data via the
native MS Access interface.

Scenario Description displays the scenario description for the current database.

Exit closes the database and shuts down the MS Access.

The Data Views screen allows access to source data for the simulation. It
can be accessed from the Main Switch Board by pressing the Data Views
button.

Microsoft Access - [IMSL: Data View Switch Board]

Great Lakes Fishery Commission

LM.S.L. Database
(Data Views)

Basins & Deployment Sites

Budget & Crew Data View & Print Data Lists

Controi Plans Scenario Description
Model Parameters
SMRT & Trap Scenario Go to Main Switch Board

Lamprey Populations

At present there are three screens allowing modification of the data:
Stream Inventory containing some stream specific data (stream parameters,
maps, spawner allocation, chemical options), Lamprey Population
providing information about lamprey population in various streams for any
of the years in the last simulation, and Data Listings (most of the individual
tables).

Additionally, the Data Views screen allows transfer of control to Scenario
Description, LCSS Reports and the Main Switch Board. The Exif button
exits the database.

ESSA Technoloqies Ltd.
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1. Stream Inventory

The Stream Inventory screen allows review and modification of the stream
and reach data, and gives accesss to the stream map (if available), stream
configurations, spawner allocations, and chemical options. It can be
accessed from the Data Views screen by selecting the Stream Inventory
button.

= Microsoft Access - [IMSL - Stream Data] vl
= Print E
Stream Current Choice [ Al J [ Erie J [ Ontario ]
Al = 449
Inventory Streams [Michigaﬂ [Tiuron ] i Superior ]
Lake Stream Name { l 25 <« Find Stream
’
IRk MNICON RIVER e Sveam Spawner
Latitude | | Code [i I p Config. Allocation
Longitude [ County Ths 0o haches | Chemical
LTMgmtZN [::} State/Prov D I3 Reach Sets | Options
ReachData - gt R [
Discharge s W (It H DS e | |
# Name (m3/5) StdDev Maximum Average (m) Area (m2) High Medium
P| TIENTIRE SYSTEM 821133 161 16.1 205 118601 0.2 0.7
2IBELOW NEW BAR.-OLD WEIf  B.211383 0] 5.4 54 20.5 39779 022 07
3ABOVE NEW BAR -OLD WEIH 821193 0f 107 10.7] 20.5 788221 0.2 0.7
Select Reach +
W] ([Record]l [of 3 D]

Select Stieam ] Close )
] (JRecord][442 Jol 443 DDl TeT 1 Ts
Form View NUM

The screen has 3 sections. At the top, buttons allow selecting subsets of
data to review by selecting one of the lakes or selecting all of the lakes at
once, left-central and the lower section present the stream and reach data,
and the right-central section gives access to other sets of information.

The data for individual streams can be selected by pressing the data control
at the bottom of the screen. This action scrolls through the set of stream
records currently selected (i.e. either all of the lakes together or one of the
individual lakes). To search for an individual stream you can also use the
Find Stream list. The list contains all of the streams in the database.

Individual stream information consists of the stream location and
designation and information about the individual reaches defined for the
stream. The list includes all of the reaches defined even if they exist in
multiple stream configurations and overlap. A more complete set of this
information is available through LCSS (see sections Biological Parameters
and Stream Setup).
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Additional information about the streams can be accessed through the
following buttons:

Map

Stream Config

Spawner Allocation

Chemical Options

stream map, if available within the database.

stream configuration tables (for discussion on stream
configurations see LCSS Concepts chapter). This
information is also available through LCSS.

spawner allocation organized by stream configuration and
stream barrier activity. This information is also available
through LCSS.

all chemical options defined for the stream (all stream
configurations). This information is also available through
LCSS.

The Close button exits the screen and returns you to Data Views screen.

2. Lamprey Populations

The Lamprey Populations screen allows you access to entered and
simulated values for the lamprey ammocete population. It can be accessed
from the Data Views screen by selecting the Lamprey Populations button.

= Microsoft Access - [IMSL - Lamprey Data] M

=| Print 3
4 Lamprey Popu|aton Custent Choice [ Erie i { Huron ] [Michigan
Superior = 134
Data for 18 ['setect Year | <t [ Ontario | [sl,pcfior |
Lake Stream # Stream Name
[ s << Find St
) (070 (T CNCONRMER_[t] << Find Stroam
Ammocete Age Data g Production Trnsfm
Reach Age Survival Density Length Migration TinsCt Density Pre  Post Year
> F. (¥ o] 525759 a a q 0
2 i 04 ol 513298 i [0 0 i i R
2 2 08 o 116.141 o [ o o i 0
2 3 0.8 o] 1306 6 B o4  d 7
Select Reach
4] ([Recod ]t Jof 22 BCIN
l Close J
(] «]Record]127 [of 134 D Tl ] [+

Form View

NUM

The top of the screen contains selection buttons for simulation year and the
lake for which you wish to view data. The central part of the screen

ESSA Technologies Ltd.
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LCSS Reports

contains a list of all ammocete characteristics by all of the reaches and ages
being simulated.

As in the Stream Inventory, screen there are 2 data controls. One allows
selection of reach and age class to be viewed or modified, the other allows
selection of a stream. To select a stream from a list, use the Find Stream
dropdown list.

3. Data Lists

The Data Lists screen is a "catch all" screen and is accessed by clicking
the View & Print Data Lists command button on the Data Views screen.
It contains a list of all of the tables in the database available for printing,
viewing and/or modification.

- Microsoft Access - [LCSS: Data Listings} v
= | File

Data Lists Available for Review & Printing

Ammocete Populations by Reach
Bames Efficiency Hypotheses

BaseCampDepiSitell ] )
Budget for Chemicals 2) Click on the Print Preview or

Budget for Crews View Data buttons.
Budget General Categories
Chemical Options by Reach Set
Chemicat Treatment Options
Deployment Sites O
E;mm Sites by Stieam Print Preview
Lamprey Basin Defintions
Lamprey Migration Basin > Stieam
Lamprey Migration Stream > Basin
Lamprey Population by Basin
Lamprey Population By Reach
Lamprey Population by Stream
Lamprey Sub-8 asin Defintions
Model Basin Paims Close
Model Gen Parms

Model Reach Paims

Model Heach Pams - Age Specific

4“1

N

To print or view a data list:
1) Selectthe data from the list

View Data

*l

Form View NUM

To use the data, select a table from the list and selelct either Print Preview
or View Data.

The LCSS Reports screen, accessible from the Main Switchboard and Data
Views screens, provides access to 2 reports and 3 graphs.
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Microsoft Access - [Select Years]

LCSS Reports

To printreports: 1) Specify the Basin and Yeers to include;
2) Seiectthe Report Type: and
3) Click on Generate Report.

Basin Configuration: [3

- Reports

[2] Basin Number [K

.

Tabular Reports
QO Transformers by Steam

O Transformers by Reach

O Stream Ammocete Populations
(O Reach Ammocete Populatons
@ Parasiic Phase Population
O Spawners by Stream

Graph Displays

O Basin Transtormer Population

O Basin Parasitic Phase Population
O Basin Spawner Population

poe YRAIS

Data are
available

' from

[ Generate Report/Graph ‘

First m

Last

rGoTa Main Switch Board j

’ GoTo View Data Switch Board ‘

I GoTo Scenario Description J

Form View

| NUM

The available reports are:
Parasitic Phase Population
Spawners by Stream

The available graphs are:
Basin Transformer Population
Basin Parasitic Phase Population
Basin Spawner Population

The summaries can

only be displayed for one specific lamprey basin. In

order to activate a report or a graph you must first select a basin

configuration and a
years for which the

basin number for which there are data and a range of
data are to be displayed.
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